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Preface

This manual describes how to build portlets for Oracle Portal (Oracle Portal) using a
variety of tools and technologies. This manual includes information that helps you
understand the various technology choices open to you, choose the technology that
best meets your requirements, and use the appropriate tools to build and deploy your
portlets.

Intended Audience

This manual is intended primarily for portal developers, but page designers may also
find it useful. This manual guides you through the process of first understanding and
choosing a portlet technology, and then building your portlets with that technology.

What Is a Portal Developer? A portal developer is a user who writes code to help
make a portal meet the specific requirements of an organization. For example, a portal
developer may build portlets and make them available to page designers and other
users for inclusion on their pages. This type of portal developer is also referred to as a
portlet developer. A portal developer may also use the public APIs provided with
OracleAS Portal to perform certain portal tasks programmatically, rather than through
the product's user interface. A portal developer will generally, although not always, be
someone with at least some programming knowledge. The privileges assigned to a
portal developer depend on the type of tasks that developer performs.

What Is a Portlet Developer? A portlet developer is a user with the following global
privileges: Create All Portal DB Providers and Manage All Shared Components. Since
OracleAS Portal offers such a wide spectrum of tools and technologies for building
portlets, a portlet developer may or may not have substantial programming
background.

Note: You can find information on using Portlet Builder in
Appendix A "Creating Portlets with the Portlet Builder" of the Oracle
Fusion Middleware Developer’s Guide for Oracle Portal 10g Release 2
(10.1.4) in the Oracle Fusion Middleware 10g Release 2 (10.1.2.0.2)
library located on the Oracle Technology Network (OTN)
(http://www.oracle.com/technology/documentation/apps
erver.html).

What Is a Page Designer? A page designer, also known as a page manager, is a user
with the Manage privilege on a page. A user with this privilege can perform any
action on the page and can create sub-pages under the page. The page designer is
often responsible for designing the layout (or region configuration) of the page and
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assigning privileges on the page to other users (for example, to determine who can
add content to the page).

The scope of a page designer's control over a page may be limited if the page is based
on a template.

For information about the different privileges in Oracle Portal and how these affect
the tasks you can perform, see the Oracle Portal User’s Guide.

Note: For the portable document format (PDF) version of this
manual, when a URL breaks onto two lines, the full URL data is not
sent to the browser when you click it. To get to the correct target of
any URL included in the PDF, copy and paste the URL into your
browser's address field. In the HTML version of this manual, you can
click a link to directly display its target in your browser.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http: //www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle
technical issues and provide customer support according to the Oracle service request
process. Information about TRS is available at
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone
numbers is available at http: //www. fcc.gov/cgb/dro/trsphonebk.html.

Related Documents

XX

For more information, see the following manuals in the Oracle Portal documentation
set:

m  Oracle Fusion Middleware Release Notes

»  Oracle Fusion Middleware User’s Guide for Oracle Portal



»  Oracle Fusion Middleware Administrator’s Guide for Oracle Portal

Note: You can find all documentation related to Oracle Portal on the
Oracle Fusion Middleware Documentation Library.

You may also find the following manuals in the Oracle Fusion Middleware
documentation set useful:

»  Oracle Fusion Middleware Concepts

»  Oracle Fusion Middleware Administrator’s Guide for Oracle HTTP Server
»  Oracle Fusion Middleware Administrator’s Guide for Oracle Web Cache

»  Oracle Fusion Middleware PL/SQL Web Toolkit Reference

Note: You can find documentation related to Oracle Fusion
Middleware on OTN
(http://www.oracle.com/technology/documentation/inde
x.html).

Conventions

The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.

<> Angle brackets enclose user-supplied names.

[1 Brackets enclose optional clauses from which you can choose one or
none.

Ellipsis points in an example mean that information not directly related
to the example has been omitted.

MW_HOME Represents the full path of the Middleware home.
ORACLE_HOME Represents the full path of the Oracle home.

ORACLE_ Represents the full path of the instance home associated with

INSTANCE ORACLE_HOME.

INFRA_ORACLE_ Represents the full path of the Oracle Application Server Infrastructure

HOME Oracle home, and is used where it is necessary to distinguish between
the middle tier, Oracle Application Server Infrastructure, or Oracle
Metadata Repository.

METADATA_REP_ Represents the full path of the OracleAS Infrastructure home

ORACLE_HOME containing the Oracle Metadata Repository, and is used where it is
necessary to distinguish between the middle tier, Oracle Application
Server Infrastructure, or Oracle Metadata Repository.
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Portlet Overview

Part I contains the following chapters:
»  Chapter 1, "Understanding Portlets"
»  Chapter 2, "Portlet Technologies Matrix"
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Understanding Portlets

This chapter provides an overview of portlets and describes, with help of examples,
the use of portlets. It explains portlet anatomy, and the resources to create portlets.
This chapter contains the following sections:

»  Section 1.1, "Introduction to Portal Development"
= Section 1.2, "Understanding Portlets"
= Section 1.3, "Portlet Anatomy"

s Section 1.4, "Portlet Resources"

1.1 Introduction to Portal Development

Oracle Portal enables you to present information from multiple, unrelated data
sources in one, organized view. This view, a portal page, can contain one or more
components—called portlets—that can each get their content from different data
sources.

Oracle Portal has all the tools you need for developing portlets and adding them to
your portal pages. Oracle Portal's tools support a wide range of development skills:
from the novice business developer to the experienced IT programmer. You can
develop portlets either declaratively, through the Oracle Portal user interface, or
programmatically, through Oracle Portal's collection of application programming
interfaces (APIs), known as the Oracle Portal Developer Kit (PDK). Additionally, you
can develop portlets through other development tools, external to Oracle Portal, and
integrate them through the PDK and an Oracle Portal entity called a provider. To learn
more about providers, see Chapter 2, "Portlet Technologies Matrix."

This chapter defines portlets, lists and describes some sources for pre-built portlets
and resources for building portlets, and suggests the best resource for the job.

1.2 Understanding Portlets

A portlet is a reusable Web component that can draw content from many different
sources. A typical portlet is one that displays summaries of Web content, as shown in
Figure 1-1.
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Figure 1-1 Portlets on the My Oracle Home Page
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For example, in your portal you may have a news feed portlet that supplies linked
news article headlines that are each accompanied by a sentence describing the content

of the article (Figure 1-2).

Figure 1-2 The Oracle News Portlet on the My Oracle Home Page

Oracle News

in multichannel shopping.

Qracle Opens Second China Development Center (CDC) in Beijing  Date Updated: 11-

B 1102003
By See how Oracle supports China's burgeoning software industry by working with its
Chinese parners and the government on joint development, knowledge transfer and

the training of local IT talent.

Users click the linked headlines to get to the full text of the article, which is hosted on
an external news service (Figure 1-3). The portlet has a somewhat dynamic nature in
that headlines change automatically as news stories are added and removed at the

source.
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Figure 1-3 Content Target from a Portlet Link
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Portlets provide a means of presenting data from multiple sources in a meaningful
and related way. Portlets can display excerpts of other Web sites, generate summaries
of key information, perform searches, and access assembled collections of information
from a variety of data sources. Because different portlets can be placed on a common
page, the user receives a single-source experience. In reality, the content may be

derived from multiple sources.

1.3 Portlet Anatomy

In Oracle Portal a portlet on a page is rendered in an HTML table cell. A portlet can
display various types of content, such as HTML, formatted text, images, or elements of
an HTML form.

Figure 14 illustrates a typical portlet anatomy. This includes a header that contains
the portlet title. You can create a hyperlink in the portlet title, so that when a user
clicks the title, the portlet displays in a full browser page. A portlet can also include a
border, to distinguish the layout from other portlets on the page.

You, the portlet developer, can expose links such as Personalize, Help, and About, to
the page designer, who can then turn them on or off. Clicking the Personalize link
displays a number of options where the end user can personalize various attributes of
the portlet. Clicking the Help link displays a window containing help text that you can
create to assist the end user with the portlet. Clicking the About link displays a
window that you can create to describe the contents of the portlet.

Each portlet also contains the refresh icon and a standard collapse icon, which the end
user can click to collapse or expand the portlet on the page.

Figure 1-4 Portlet Anatomy
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1.4 Portlet Resources

Portlet resources include the many prebuilt portlets available out of the box from
many sources, including Oracle Portal, Oracle E-Business Suite, and third-party
sources. Portlet resources also include portlet-building tools available through the
Oracle Portal user interface as well as from the PDK and other Oracle tools. Each of
these tools offers different product features that are targeted toward different
developer roles.

This section describes different portlet resources, suggests the level of expertise
required to use them, and provides examples of when they might best be used. It
includes the following subsections:

s Section 1.4.1, "Out-of-the-Box Portlets"

m  Section 1.4.2, "Other Sources of Prebuilt Portlets"
= Section 1.4.3, "Web Clipping"

s Section 1.4.4, "OmniPortlet"

m Section 1.4.5, "Portlet Builder"

= Section 1.4.7, "Programmatic Portlets"

This section introduces you to the various portlet resources. For specific information
on each tool and its benefits, see Chapter 2, "Portlet Technologies Matrix."

1.4.1 Out-of-the-Box Portlets

What Are They?

Out-of-the-box portlets are prebuilt, fully developed, registered portlets that are
immediately available from the Portlet Repository when you install Oracle Portal

(Figure 1-5). They include such portlets as Search, Saved Searches, Favorites, and My
Notifications.

Figure 1-5 The Portlet Repository
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You'll find information on the prebuilt portlets in Oracle Portal in Oracle Fusion
Middleware User’s Guide for Oracle Portal.
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Who Is the Intended User?

Out-of-the-box portlets are best suited for use by end users and page designers,
though they are available to users at all levels of expertise.

When Should They Be Used?

Use out-of-the-box portlets when your needs are satisfied by the functions the portlets
offer, and the level of personalization readily available is sufficient to complete the
desired task.

Consider alternatives when you need to extend or personalize the portlet, such as
when you need a different user interface, or when the functionality you require is not
available out of the box.

For more information on when you should use each technology, see Chapter 2, "Portlet
Technologies Matrix."

1.4.2 Other Sources of Prebuilt Portlets

Bl
T

Dlowe |

T
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What Are They?
Other sources of prebuilt portlets include partner portlets and integration solutions.

Partner portlets are available through Oracle's partnerships with leading system
integrators, software vendors, and content providers. You can access these portlets by
using the keywords portal or portlet when searching the Oracle PartnerNetwork
Solutions Catalog:

http://solutions.oracle.com

Examples of these prebuilt portlets include portlets for the following purposes:
= Generating point-to-point driving directions

»  Accessing IT information from a wide variety of sources

= Viewing summary information on news, stocks, and weather

Portal Integration (POINT) Solutions provide solutions for customers who require
basic functionality for popular applications such as Microsoft Exchange, Lotus Notes,
SAP, IMAP, SMTP, and the like. These portlets are available on the Oracle Portal
Integration Solutions page on OTN:

http://www.oracle.com/technology/products/ias/portal/point.html

Who Is the Intended User?

Fully developed, downloadable portlets are best suited for use by end users and page
designers who understand how to download, install, and register Web and database
providers in Oracle Portal. They are available for use by all levels of experience.

When Should They Be Used?

As with out-of-the-box portlets, use prebuilt portlets from other sources when your
needs are satisfied by the functions the portlets offer, and the level of personalization
readily available is sufficient to complete the desired task.

Consider alternatives when you need to extend or personalize the portlet, for example,
when you need a different user interface or when the functionality you require is not
available out of the box.
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1.4.3 Web Clipping

What Is 1t?

Web Clipping is a browser-based declarative tool that enables you to integrate any
Web application with Oracle Portal. It is designed to give you quick integration by
leveraging the Web application's existing user interface. Web Clipping has been
implemented as a Web provider using the PDK-Java, which is a component of Oracle
Portal.

To create a Web Clipping portlet, the portal page designer uses a Web browser to
navigate to the Web page that contains the desired content. Through the Web Clipping
Studio, the page designer can drill down through a visual rendering of the target page
to choose the desired the content (Figure 1-6 and Figure 1-7).

Figure 1-6 Selecting Web Content through the Web Clipping Studio
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Figure 1-7 Clipped Content Rendered as a Portlet in Portal
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Web Clipping supports the following:

Navigation through various styles of login mechanisms, including form- and
JavaScript-based submission and HTTP Basic and Digest Authentication with
cookie-based session management.

Fuzzy matching of clippings. If a Web clipping gets reordered within the source
page or if its character font, size, or style changes, it will still be identified correctly
by the Web Clipping engine and delivered as the portlet content.

Reuse of a wide range of Web content, including basic support of pages written
with HTML 4.0.1, JavaScript, applets, and plug-in enabled content, retrieved
through HTTP GET and POST (form submission).

Personalization, allowing a page designer to expose input parameters that page
viewers can modify when they personalize the portlet. These parameters can be
exposed as public parameters that a page designer can map as Oracle Portal page
parameters. This feature enables end users to obtain personalized clippings.

Integrated authenticated Web content through Single Sign-On, including
integration with external applications, which enables you to leverage Oracle
Application Server Single Sign-On and to clip content from authenticated external
Web sites.

Inline rendering, enabling you to set up Web Clipping portlets to display links
within the context of the portlet. As a result, when a user clicks a link in the Web
Clipping portlet, the results display within the same portlet. You can use this
feature with internal and external Web sites.

Proxy Authentication, including support for global proxy authentication and
per-user authentication. You can specify the realm of the proxy server and
whether all users will automatically log in using a user name and password you
provide, each user will log in using an individual user name and password, or all
users will log in using a specified user name and password.

Resource Tunnelling of images.
Open Transport API for customizing authentication mechanisms to clipped sites.

Security Enhancement that enables administrators to control access to content
that can be clipped by the Web Clipping portlet.

Migration from URL-based portlets, enabling you to migrate your URL-based
portlets to Web Clipping.

Understanding Portlets 1-7
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Who Is the Intended User?

Web Clipping is best suited for use by page designers and portlet developers who
want to leverage an existing Web page for rapid portlet development. The Web
Clipping portlet is accessible out of the box, and is available in the Portlet Repository
of Oracle Portal. This portlet can be added to a page by any user with the appropriate
privileges.

When Should It Be Used?

Use Web Clipping when you want to repurpose live content and functionality from an
existing Web page and expose it in your portal as a portlet. Consider alternatives if
you want to change the way information is presented in the clipped portlet. That is,
you don't need to control the user interface or application flow, and you are accessing
Web-based applications. For a greater level of control, use OmniPortlet's Web page
data source instead of Web Clipping.

The following are some examples of when you might consider using the Web Clipping
portlet:

= Stock chart portlet. You want to create a portlet that displays the stock market's
daily performance chart from your financial advisor's Web site. You could clip this
information from an external Web site, even if your company is using a proxy.

»  Personalized weather portlet. You want to create a portlet that displays weather
information from a major Internet weather site, and you want your users to be
able to personalize the portlet by providing the desired zip code.

= Web mail portlet. Your users want to access their confidential Web mail accounts
through a portlet and display their in-boxes in the portlet.

For more information on using Web Clipping, see Chapter 5, "Creating Content-Based
Portlets with Web Clipping."

Note: To use the Web Clipping portlet, OmniPortlet, or the Simple
Parameter Form with Windows (2000 with SP4, 2003 (32 bit) with
SP2/R2 or later, XP with SP2/R2 or later, Vista, and Server 2008),
you must use Firefox 3.0 or later, or Microsoft Internet Explorer 7 or
later.

1.4.4 OmniPortlet

What Is 1t?

OmniPortlet is a declarative portlet-building tool that enables you to build portlets
against a variety of data sources, including XML files, character-separated value files
(CSV, for example, spreadsheets), Web Services, databases, Web pages, and SAP data
sources. OmniPortlet users can also choose a prebuilt layout for the data. Prebuilt
layouts include tabular, news, bullet, form, chart, or HTML. HTML layout enables
OmniPortlet users to write their own HTML and inject the data into that HTML.
Figure 1-8 shows an OmniPortlet with a tabular format.
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Figure 1-8 An OmniPortlet Using Tabular Format
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Note: The SAP data source is not included with Oracle Portal. To
learn more about using the SAP data source, visit the Oracle Portal
Integration Solutions page on OTN:

http://www.oracle.com/technology/products/ias/port
al/point.html

Like Web Clipping, OmniPortlet supports proxy authentication, including support for
global proxy authentication as well as authentication for each user. You can specify
whether all users will automatically log in using a user name and password you
provide, each user will log in using an individual user name and password, or all
users will log in using a specified user name and password.

You'll find information about OmniPortlet on Portal Center. Navigate to the following
URL, then click Portlet Development:

http://portalcenter.oracle.com

Who Is the Intended User?

OmniPortlet is best suited for use by business users with a minimum knowlegde of the
URLSs to their targeted data.

When Should It Be Used?

Use OmniPortlet when you want to build portlets rapidly against a variety of data
sources with a variety of layouts. Consider alternatives when you want complete
control of the design and functionality of the portlet.

The following are some examples of when you might consider using OmniPortlet:

= RSS news feed portlet. You want to create a portlet that displays live, scrolling
news information to your users. The data comes from a Really Simple Syndication
(RSS) news feed, such as the Oracle Technology Network Headlines. You also
want the portlet to contain hyperlinks to the news source.

= Sales chart portlet. You want to present up-to-date information on your
company's sales results. You also want to display data in the form of a pie chart,
and your company stores its sales information in a remote relational database.

= SAP portlet. You want to display information from a company's SAP system. To
minimize the load on the company's SAP Business Suite, the information retrieved
from the system must be cached for each user for the entire day.

For more information about OmniPortlet, see Chapter 3, "Creating Portlets with
OmniPortlet" and Chapter 4, "Building Example Portlets with OmniPortlet."

Understanding Portlets 1-9



Portlet Resources

1.4.5 Portlet Builder

What Is 1t?

Oracle Portal includes a number of portlet-building wizards that are accessible
through the Provider tab in the Portal Navigator. These wizards can be used to build
charts, reports, forms, calendars, and lists of values as shown in Figure 1-9.

Figure 1-9 Sample Form, Report, and Chart from the Portlet Builder

Sample Form  Customize T = Sample Report Customize ¥ = W Sample Chart Customize F |
Insert | Cluery | Reset Depﬁ“"‘;“‘ Manager Employee Joh ciere [ 1,028
umber saLesmen [N 1,400
Deptno 10 7782 MLLER  CLERK MANARER 2758
Dname 10 7838 CLARK  MANAGER ANSLYST 3,000
Loc 10 (nul) KNG presipent | | PREsiDEnT I - 000
20 7566 FORD ANSLYST
Insenl Cluery | Reset
20 7566 SCOTT  ANSLYST

20 TrEE ADAMS  CLERK
20 7839 JOMNES MANAGER
20 7a02 SMITH CLERK
30 TE98 ALLEM SALESMAN
30 TE9S JAMES CLERK
30 TE98 MARTIN - SALESMAN
30 7695 TURNER  SALESMAN
30 TEIE WARD SALESMAN
30 TE39 BLAKE h&MNAGER

When Should It Be Used?

It is recommended that you use OmniPortlet as an alternative to Portlet Builder
whenever possible. OmniPortlet provides more flexibility and a separation of data and
layout which enables you to change from a report to chart without re-creating the
entire portlet (as is required with Portlet Builder). OmniPortlet also provides more
options for deployment to many different portals simultaneously. Oracle Portal will
continue to support Portlet Builder as a portlet building option. However, new
features and enhancements will be directed toward the OmniPortlet tool.

For more information about OmniPortlet, see Section 1.4.4, "OmniPortlet." For more
information about Portlet Builder, see Appendix A, "Creating Portlets with the Portlet
Builder."

1.4.6 JSF Portlets

What Are They?

JSF portlets are created using the JSF Portlet Bridge. The JSF Portlet Bridge enables
application developers to expose their existing JSF applications and task flows as JSR
168 portlets. The portlet bridge simplifies the integration of JSF applications with
WSRP portlet consumers, such as Oracle Portal.

JSF portlets do not require separate source code from that of the JSF application. Since
these portlets are created using the portlet bridge, you need to only maintain one
source for both your application and your portlets. Similarly, when you deploy your
JSF application, JSF portlets are also deployed with it. Therefore, using the bridge
eliminates the need to store, maintain, and deploy your portlets separately from your
application.
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Note: ]SF Portlet Bridge integrate Oracle WebCenter Services into
Oracle Portal. It is only available if you are using a licensed Oracle
WebCentre.

Who Is the Intended User?
Application developers with knowledge of Faces and WSRP.

When Should They Be Used?

JSF portlets are best suited when application developers intend to display contents
from a JSF application as a portlet without hosting the entire application, or without
separately building a portlet for the same. Once portletized, the consumption of the
portlet is the same as registering any WSRP provider using their provider URLs.

For more information, see Oracle Fusion Middleware Developer’s Guide for Oracle
WebCenter Suite.

1.4.7 Programmatic Portlets

What Are They?

Programmatic portlets are portlets that you write yourself, in Java or PL/SQL. The
Oracle PDK contains a set of portlet-building APIs that you can use to create
programmatic portlets.

You'll find more information about these APIs on Portal Center:
B O
OTN http://portalcenter.oracle.com

Note: The PDK-PL/SQL is not described in detail in this manual. For
specific information on the PDK-PL/SQL, refer to the Developer
Services area on Portal Center:

http://portalcenter.oracle.com

Who Is the Intended User?
These tools are best used by experienced and knowledgeable IT developers.

When Should They Be Used?

Use programmatic portlets when you have very specialized business rules or logic or
when you require personalized authentication, granular processing of dynamic results,
and complete user interface control. Additionally, use programmatic portlets when
you need to satisfy any of the following conditions:

= You're building a portlet from the start and need complete control over all of its
functionality.

s You know Java or PL/SQL.

= You are comfortable with the PDK and the configuration of Oracle Portal
providers.

Consider using this approach when the out-of-the-box declarative tools do not address
your needs.

The following are some examples of when you might consider using Java portlets
created with the Oracle Portal Developer Kit:
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= Discussion forum portlet. You want to create a portlet that integrates your
company's JSP-based discussion forum application with Oracle Portal. The
discussion forum posts are stored in a relational database. The portlet must also
follow the strict look and feel of your company's Internet Web site.

s E-mail portlet. You want to create a portlet that enables users to send e-mail from
the company's intranet portal. You must integrate the e-mail portlet with the

company's LDAP server so that the users can use the address book on the LDAP
server.

For more information about using the PDK-Java, see Chapter 6, "Creating Java
Portlets" and Chapter 7, "Enhancing Java Portlets." For more information about using
the PDK-PL/SQL, see Chapter 8, "Creating PL/SQL Portlets."

1.4.8 Deciding Which Tool to Use

Figure 1-10 illustrates the spectrum of portlet resources described in the previous
section. Notice how one end of the spectrum is geared toward a more declarative
environment as required by page designers while the other end focuses more on
hand-coding and portlet developers. You can choose your tool depending on which
type of environment is most comfortable and suitable for your skill-base.

For more information on deciding which tool to use, refer to Chapter 2, "Portlet
Technologies Matrix".

Figure 1-10 Portlet Resources from Page Designers to Experienced Developers
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Portlet Technologies Matrix

This chapter describes portlet features, characteristics, technologies, and tools to help
you decide which portlet building technology best suits your needs. It includes the
following sections:

Section 2.1, "The Portlet Technologies Matrix"

Section 2.2, "General Suitability"

Section 2.3, "Expertise Required"

Section 2.4, "Deployment Type"

Section 2.5, "Caching Style"

Section 2.6, "Development Tool"

Section 2.7, "Portlet Creation Style"

Section 2.8, "User Interface Flexibility"

Section 2.9, "Ability to Capture Content from Web Sites"

Section 2.10, "Ability to Render Content Inline"

Section 2.11, "Charting Capability"

Section 2.12, "Public Portlet Parameters Support"

Section 2.13, "Private Portlet Parameter Support"

Section 2.14, "Event Support"

Section 2.15, "Ability to Hide and Show Portlets Based on User Privileges"
Section 2.16, "Multilingual Support”

Section 2.17, "Pagination Support"

Section 2.18, "Single Sign-On and External Application Integration"

2.1 The Portlet Technologies Matrix

Table 2-1, " Portlet Building Technologies Comparison Matrix" summarizes the
technologies and tools you can use with Oracle Portal on one axis, and the features
and characteristics on the other. The matrix describes the tools and technologies that
are covered in more detail in this guide: OmniPortlet, Web Clipping, the Java Portlets
(PDK-Java) including Standards, Portlet Builder as an appendix, and PL/SQL Portlets
(PDK-PL/SQL) (in the matrix only).
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Note:

While these are the primary tools for building portlets,

additional tools and technologies exist, such as other Oracle products,
including Oracle Reports and Oracle Business Intelligence Discoverer.
These other tools are not covered in this guide.

The other sections in this chapter provide further detail on the characteristics listed in
Table 2-1. Use the table to quickly scan all the features and characteristics, then see the

subsequent sections for more in-depth information.

Table 2-1 Portlet Building Technologies Comparison Matrix

Web Clipping OmniPortlet PDK-Java Standards Portlet Builder PDK-PL/SQL
General Suitability

A simple Wizard-based tool, APIs for portlets Portlets that should Wizard-based tool, APIs for portlets
wizard-based tool  accessible from the built specifically for work with portals  accessible from the built specifically for
that helps you browser. Capable Oracle Portal. of other vendors. browser. Best Oracle Portal.
retrieve and of retrieving and Oracle supports suited for simple,

present Web presenting data both WSRP and DB-centric

content, originating from a wide variety JSR-168. applications or

from other Web of data sources. portlets.

sites, in your portal.

Expertise Required

No expertise Basic Java, Servlet, JSP Java, Servlet, JSP Basic SQL, PL/SQL,

required. understanding of ~ knowledge. knowledge. understanding of ~ PL/SQL Web
one or more relational DB Toolkit.
supported data concepts.
sources and the Optionally SQL,
concepts of portlet PL/SQL.
and page
parameters and
events.
Supported Data
Sources (for details,
see Section 2.3,
"Expertise
Required")
Any Web site CSV, XML, Web No limitations. No limitations. SQL (local DB or SQL (local DB or
accessible on the Service, SAP, SQL, remote DB through remote DB through
network over Web site, JCA. DB link) DB link)
HTTP or HTTPS.
Deployment Type
Web provider Web provider Web provider WSRP Database provider = Database provider
Caching Style
Expiry-based Expiry-based Expiry-based, Validation and Expiry-based Expiry-based,
caching, caching, validation, and expiry-based caching. validation, and
invalidation-based  invalidation-based invalidation caching. invalidation
caching (auto caching (auto caching, ESI. caching.
invalidate when invalidate when
personalized). personalized).
Development Tool
Browser - wizard.  Browser - wizard.  Oracle JDeveloper - Oracle JDeveloper - Browser - PL/SQL
Java Portlet Wizard Java Portlet Wizard optionally PL/SQL development
(or any other Java  (or any other Java  development environment.
development development environment.
environment - environment -
without the without the
Wizard). Wizard).

Portlet Creation
Style
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Table 2-1 (Cont.) Portlet Building Technologies Comparison Matrix

Web Clipping

OmniPortlet

PDK-Java

Standards

Portlet Builder

PDK-PL/SQL

Develop in place.

Develop in place.

No in-place portlet
building
experience. Add

No in-place portlet
building
experience. Add

Develop first, then
add and develop in
place.

No in-place portlet
building
experience. Add

portlet to page, edit portlet to page, edit portlet to page, edit
defaults, and defaults, and defaults, and
personalize. personalize. personalize.
User Interface
Flexibility
N/A Very flexible, by Very flexible. Very flexible. Limited. Very flexible.
using the HTML
layout.
Ability to Capture
Content from Web
Sites
Yes, by its nature. Yes, by using the Yes, by using the Yes, by using the No Yes, by using the

Web Data Source.  java.net package. java.net package. UTIL_HTTP
package.
Ability to Render
Content Inline
Yes. (Supported by No URL rewriting By using private Include servlets Pagination in By using private
Web Clipping support, but can be portlet parameters. and JSPs (using the reports and charts ~ portlet parameters.
9.0.4.0.2 or later.) achieved by using PortletContext.getR is rendered inline.
public portlet equestDispatcher()
parameters and method).
events.
Charting
Capability
N/A Yes, 2D-3D charts. By using Bl Beans. By using Bl Beans. = HTML charts. Programmatically,
HTML charts.
Public Portlet
Parameters
Support
Yes. (Supported by  Yes Yes No Yes Yes
Web Clipping
9.0.4.0.2 or later.)
Private Portlet
Parameter Support
N/A N/A Yes Yes No Yes
Event Support
Yes Yes Yes Portlet private No No
events (actions).
Ability to Hide
and Show Portlets
Based on User
Privileges
No, though it is No, though it is Yes, by using the Yes, the Servlet Yes Yes, by using the
possible to apply possible to apply Security managers. security model is Security APIs.
security managers  security managers supported by using
that are not that are not methods such as
exposed through exposed through PortletRequest.isUs
the UL the UL erInRole() and
PortletRequest.get
UserPrincipal().
Multilingual
Support
N/A Yes Yes Yes No Yes
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Table 2-1 (Cont.) Portlet Building Technologies Comparison Matrix

Web Clipping OmniPortlet PDK-Java Standards Portlet Builder PDK-PL/SQL
Pagination

Support

N/A No Programmatically =~ Programmatically ~ Yes Programmatically
Single Sign-On

and External

Application

Integration

Web Clipping Basic External No. (Feasible No. (It runsin the ~ SSO is enabled by
9.0.4.0.2 and higher authentication application through custom Oracle Portal using mod_oso.
supports external ~ support if the data  integration user attributes.) repository; it does

application source requires it. ~ supported. LDAP ~ LDAP integration  not require SSO

integration. integration is is supported. integration.)

supported when
the portlet is
running behind the
same firewall as the
LDAP server.

2.2 General Suitability

This section describes each portlet-building technology in terms of its usage
characteristics (for example, wizard-based or programmatic).

2.2.1 Web Clipping

Web Clipping is a simple wizard-based tool that helps you retrieve and present Web
content, originating from other Web sites, in your portal. Web Clipping does not
require you to have any technical background.

Examples of portlets you can build using Web Clipping
You can build the following portlets using Web Clipping:

= Stock chart portlet

»  Personalized weather portlet

= Web mail portlet

2.2.2 OmniPortlet

OmniPortlet is an easy-to-use, wizard-based tool for presenting information from a
wide variety of data sources in a variety of formats. OmniPortlet runs completely in
the browser. Drop OmniPortlet on a portal page, click the Define link, and choose a
data source and presentation format. Select from a wide variety of data sources
including the following;:

= Spreadsheet
= SQL

= XML

»  Web Service
= Web page

OmniPortlet does not require you to use an additional development tool or have a
strong technical background. Even so, you can use it to build reusable and
high-performing portlets.
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Examples of portlets you can create with OmniPortlet
You can create the following portlets using OmniPortlet:

s RSS news feed portlet
»  Sales chart portlet
= SAP Business Suite portlet

2.2.3 Java Portlets

If the wizard-based portlet building tools do not satisfy your needs, you can build
your portlets programmatically using Java. The Java Community Process standardized
the Java portlet APIs in 2003. Portlets built against the Java Specification Request (JSR)
168 standard are interoperable across different portal platforms. The Java Portlet
Wizard, an Oracle JDeveloper plug-in, helps you get started with your Java portlets.

Note: When building portlets in Java, you have full control over
your portlet's functionality. For example, you can control what it looks
like and how it behaves.

Examples of portlets you can build using Java
You can build the following portlets in Java:

= Discussion forum portlet

s E-mail portlet

2.2.4 Portlet Builder

Portlet Builder is a wizard-based tool to create data-driven portlets, where the data
resides in an Oracle database. You can build interactive forms to insert, update, and
delete database records. You can create flexible reports and HTML bar charts to
display information from the database. Portlet Builder also enables you to pass
parameters and navigate between your data-driven portlets by using dynamic links.

Examples of portlets you can build using the Portlet Builder
You can build the following portlets using Portlet Builder:

= Data entry portlet
= Dynamic list of partners portlet

= Sales results portlet

2.2.5 PL/SQL Portlets

Similar to Java portlets, PL/SQL portlets provide a flexible approach to build Web
applications that cannot be satisfied by built-in portlets. For example, your application
may require implementation of special business rules or logic or meet
custom-designed authorization requirements. PL/SQL portlets are commonly used
when you need to perform data intensive operations by using SQL and PL/SQL.
Oracle Portal offers a rich set of PL/SQL APIs, such as programmatic provider
registration, object level privilege management, user interface control, or multilingual
support.

For example, any information provider can create custom portlets to display an
application to users through Oracle Portal. Developers simply build their portlets
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according to Oracle Portal Developer Kit (PDK) specifications and register the
provider with Oracle Portal. Developers can use the Oracle PDK to develop portlets to

suit their needs.

Examples of portlets you can build using PL/SQL
You can build the following portlets using PL/SQL:

= Content upload portlet
= Site map portlet

= Sophisticated data entry and report portlet

2.3 Expertise Required

While some of the portlet building tools do not require portlet development skills,
others assume a strong technical background. This section describes each tool in terms
of the level of knowledge required to use it effectively.

2.3.1 Web Clipping

Web Clipping is a tool that does not require any technical background at all. However,
if you want to parameterize the Web page content that you clipped, you need to have
an understanding of public portlet parameters and page parameters.

2.3.2 OmniPortlet

OmniPortlet requires you to have basic knowledge of the data source you want to
leverage in your portlet. Table 2-2 lists the types of data sources that can be used with
OmniPortlet and describes the type of information required to work with each type.

Table 2-2 OmniPortlet Data Sources

Data Source

Required Information

Spreadsheet
SQL
XML

Web Service

Web page

J2EE Connector
Architecture

The URL that points to the spreadsheet containing the data that
you want to display in the portlet.

The connection information to the data source and the SQL
query that retrieves the data from the database.

The location of the XML source and optionally the address of the
XSL filter and the XML schema.

The Web Services Description Language (WSDL) URL, the
method of the Web service, and optionally the XSL filter URL
and the XML schema URL.

The Web page data source uses the same environment as Web
Clipping. No technical background is required.

Although not displayed on the OmniPortlet Wizard’s Type
page, a J2EE Connector Architecture (JCA) 1.0 adapter is also
available. JCA provides a mechanism to store and retrieve
enterprise data such as that held in ERP systems (Oracle
Financials, SAP, PeopleSoft, and so on).

2.3.3 Java Portlets

To build Java portlets, you must know at least a subset of J2EE. Knowing HTML, Java
servlets, and XML is a must, and JSP experience is recommended. Additional Java
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knowledge is optional, depending on the task you want to perform. Using Java
portlets you can access any data source (supported by the Java language).

2.3.4 Portlet Builder

If you want to use Portlet Builder, you must have a good understanding of relational
database concepts. Depending on what you want to achieve, SQL and PL/SQL
knowledge may be required, as well. Using Portlet Builder, you can consume data
from the local (Oracle Fusion Middleware infrastructure) database or remote
databases using database links.

2.3.5 PL/SQL Portlets

To build PL/SQL portlets, you must know how to write SQL statements, code and
debug PL/SQL program units using SQL*Plus or similar development tool that
enables you to connect to the Oracle database. You should also know HTML and
PL/SQL Web Toolkit to generate the portlet content. Experience of coding the PL/SQL
Server Pages (PSP) is optional.

2.4 Deployment Type

Before a portlet can be consumed by an application, you must first deploy it, then
register the provider you have deployed the portlet to. As shown in Figure 2-1,
portlets can be deployed to Oracle Portal through three provider types:

= Web providers
= WSRP producers
= Database providers.

Web providers are deployed to a J2EE application server, which is often remote and
communicates with Oracle Portal through Simple Object Access Protocol (SOAP) over
HTTP. Web Services for Remote Portlets (WSRP), an OASIS standard, is supported in
the Developer's Preview of Oracle Portal. Database providers are implemented in
PL/SQL and deployed in the Oracle database where Oracle Portal is installed.

Figure 2—1 Portlet Provider Overview
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Portlet Technologies Matrix 2-7



Deployment Type

2.4.1 Web Providers

Web providers are the most commonly used and flexible type of provider. They may
reside on the same application server as Oracle Portal, on a remote application server,
or anywhere on the network (Figure 2-2). A Web provider could be implemented
using virtually any Web technology. However, the Oracle Portal Developer Kit
provides a Java framework that simplifies the task of building Web providers.

Web providers use open standards, such as XML, SOAP, HTTP, or J2EE for
deployment, definition, and communication with Oracle Portal. Also, because Web
providers can be deployed to a J2EE container, they do not put an additional load on
the Oracle Portal Repository database.

Figure 2-2 Web Providers

OracleAS Portal
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There are several benefits when developing portlets and exposing them as Web
providers. You can perform the following tasks:

= Deploy portlets remotely.

»  Leverage existing Web application code to create portlets.

= Specify providers declaratively.

»  Take advantage of more functionality than that with database providers.

= Use standard Java technologies (for example, servlets and JSPs) to develop portlets
of Web providers.

To expose your portlets using a Web provider, you must create a provider that
manages your portlets and can communicate with Oracle Portal using SOAP. To learn
how to expose your portlets using a Web provider, see Section 6.3, "Building
JPS-Compliant Portlets with Oracle JDeveloper."

2.4.2 WSRP Producers

Web Services for Remote Portlets (WSRP) is a Web services standard that enables the
plug-and-play of visual, user-facing Web services with portals or other intermediary
Web applications. Being a standard, WSRP enables interoperability between a
standards-enabled container based on a particular language (such as JSR 168, .NET,
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Perl) and any WSRP portal. So, a portlet (regardless of language) deployed to a
WSRP-enabled container can be rendered on any portal that supports this standard.
From an architecture perspective, WSRP producers are very similar to Web providers.
For more information on the WSRP portal architecture, see "The Relationship Between
WSRP and JPS".

To expose your portlets as a WSRP producer, you must create a producer that manages
your portlets. To learn more about WSRP, see the WSRP and JSR 168 Standards page
on the Oracle Technology Network. To learn how to expose your portlets as a WSRP
producer, see Section 6.3.3, "Deploying Your JSR 168 Portlet to the Oracle WebLogic
Server." You can also test your WSRP producers online using the Oracle Portal
Verification Service:

http://portalstandards.oracle.com

By default, the Portal session store maintains the user's profile information, which is
obtained from Oracle Internet Directory, for the duration of a Portal session.

However, in some scenarios, WSRP producers require updates to the WSRP
UserContext information sent to them. This information changes during the course of
the session. In this scenario, to clear out the cached user information and obtain new
information from Oracle Internet Directory when the target page is generated, the
application or portlet producer redirects the browser to the following URL:

http(s) ://server.domain.com:port/portal/pls/portal/portal .wwsec_app_user_
info.flush_cache?p_requested_url=<url-encoded-target-page>

2.4.3 Database Providers

You can also create a database provider that owns one or more PL/SQL portlets.
Database providers and their PL/SQL portlets reside in the Oracle Metadata
Repository database and are implemented as PL/SQL packages. To access database
providers on remote servers, you can use the Federated Portal Adapter (Figure 2-3).
For more information about the Federated Portal Adapter, see Oracle Fusion Middleware
Administrator’s Guide for Oracle Portal.
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Figure 2-3 Database Providers
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Database providers are ideal when you need to perform data-intensive operations
using PL/SQL. An example of this is when you are building forms or charts with the
Oracle Portal user interface or the PL/SQL APIs provided in the PDK.

To learn how to expose your PL/SQL portlets using a database provider, refer to
Section 8.13, "Registering Providers Programmatically".

2.4.4 Provider Architecture

Figure 2—4 illustrates the basic architecture of portlet providers.
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When users display the portal page in their Web browsers, the flow of the request
works as follows:

1.

The user requests a portal page from the Web browser by entering a URL in the
browser's address field.

The Parallel Page Engine (PPE), which resides in the Oracle Fusion Middleware's
middle tier, retrieves the portal page layout, portlet, and provider information
(also called the page metadata) from the Oracle Portal Repository.

Note: The PPE is responsible for constructing the requested portal
page based on the page metadata.

The PPE contacts all the providers for the portlet content.

The providers make the necessary calls to their portlets so that the portlets
generate the portlet content in the form of HTML or XML code.

The providers return the portlet content back to the PPE.

The PPE assembles the portal page, and the Oracle Fusion Middleware returns the
page to the Web browser.

For more information about the portlet and provider architecture, visit the Portlet
Development page on Portal Center:

http://portalcenter.oracle.com

Web Clipping, OmniPortlet, and Java portlets communicate with Oracle Portal
through Web providers. After you install Oracle Portal, Web Clipping and OmniPortlet
are ready to use; their providers are registered with Oracle Portal out of the box. You
have to register the provider of your Java portlets explicitly.
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Note: Web Clipping and OmniPortlet are developing very rapidly.
The most recent versions of these portlets are available for download
on OTN. If you decide to go with the downloaded version of these
tools, you must deploy them to Oracle WebLogic Server and register
them with Oracle Portal as Web providers. For more information, see
Oracle Fusion Middleware Administrator’s Guide for Oracle Portal.

Data-driven portlets, built with Portlet Builder, communicate with Oracle Portal
through database providers. You do not need to register the Portlet Builder providers
with Oracle Portal explicitly; they are automatically registered for you.

PL/SQL portlets communicate with Oracle Portal through a database provider. You
have to register the database provider explicitly.

2.4.5 Provider Registration

Oracle Portal includes a provider registration wizard, accessible from the Providers
tab in the Navigator. The registration screen contains the following sections:

= Provider Information: Contains the provider name, time out details, and the
implementation style.

s User/Session Information: Contains information on how session information is
communicated to the providers.

= Database Providers: Contains information specific to database providers, such as
the implementation owner and name.

= Web Providers: Contains information specific to Web providers, such as the URL
of the provider, the user's identity communicated to the provider, and proxy
information.

s WSRP Producers: Contains information specific to WSRP producers, such as the
WSDL URL and the session handling information supplied by the producer.

The sections that impact session handling are the User/Session Information section
and the cookie domain check box on the Web provider registration page of the wizard.
For more information on using the same cookie domain, refer to the "Sharing Session
Cookies Not Allowed in PDK-Java Release 2" article, which can be accessed from the
Portlet Development page on Portal Center
(http://www.oracle.com/technology/products/ias/portal/portlet_
development_10gr2.html).

User/Session Information

In the User/Session Information section, you can choose one of two options,
depending on the session-related information you want the providers to receive from
Oracle Portal. The options are as follows:

s Public: Choosing this option sets the name of the user to Public. The providers
will not receive any session-related information like the session ID or the time the
user logged in. This option is the equivalent of the LOGIN_FREQUENCY_PUBLIC
in the provider registration API (see Section 8.13, "Registering Providers
Programmatically”).

= User: Choosing this option sends the name of the Oracle Portal user to the
providers. This section contains the following two options:
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= Login Frequency: Here, you can select one of three options (always, once for
each user session, and never) to determine how often the session information
must be sent to the provider, and thus how often the user needs to log in.

= Require Portal user-specific session information: Here, you can specify
whether the session information will be sent in the provider calls.

2.5 Caching Style

Caching plays an essential role in ensuring that your portal is highly performant.
Oracle Portal supports caching on various levels, such as caching pages, portlets,
styles, and page metadata. Caching portlets is key to delivering accurate information
in a timely manner to your users. All portlet building technologies, available with
Oracle Portal, support caching.

As Oracle Portal supports user personalization of pages and portlets, the view of a
page can vary from user to user. Oracle Portal's caching is designed to allow content to
vary for each user. Therefore, portal objects, including portlets, can be cached at two
levels, user level and system level, and can be described as follows:

»  User-level caching is for a specific user; the cache entries stored are unique for that
user and cannot be accessed by other users. Good candidates for user-level
caching are portlets supporting personalization, such as e-mail or stock ticker
portlets.

= System-level caching enables users to share a single cache entry and, therefore,
there is no need to cache a copy of the object for every user. Examples of content
that might be suitable for system-level caching are news portlets that are not
personalizable, or custom-built navigation portlets.

When not using caching, you may find accessing various data sources with Web
Clipping, OmniPortlet, and Portlet Builder to be time consuming. When you enable
caching, you instruct Oracle Portal or Oracle Web Cache to maintain a copy of the
portlet content. If the portlet is requested and the content was cached previously, the
portlet does not have to spend time contacting the data source and regenerating its
content again. Simply, the previously cached portlet content is returned. Different
types of caching are as follows:

»  Expiry-based caching: Consider using expiry-based caching when the portlet
content is static or when it is not critical that the most up-to-date content be
displayed. When using expiry-based caching, you must specify the caching
period.

= Validation-based caching: Consider using validation-based caching for portlets
with dynamic content that changes frequently or unpredictably. The portlet
associates its content with a caching key and returns the key value along with the
content. When the portlet content is requested, the portlet decides, based on the
caching key, if the current content is valid. If the portlet content is valid, then it
returns a response indicating that the cached content can be used (that is, the
content is valid) or generates the new portlet content and returns it along with a
new caching key for that content.

» Invalidation-based caching: Invalidation-based caching is the most complex, but
also the most flexible, form of caching. Consider using invalidation-based caching
when you require the efficiency of expiry-based caching with the ability to
invalidate the cache content any time. Objects in Oracle Web Cache are considered
valid until they are invalidated explicitly.
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2.5.1 Web Clipping, OmniPortlet, and Portlet Builder

For portlets built with Web Clipping, OmniPortlet, and Portlet Builder you can specify
a period of time for which they are cached (expiry-based caching). In addition to this,
portlets built with Web Clipping and OmniPortlet are refreshed automatically when
the end user personalizes them.

2.5.2 Java Portlets

Java portlets support three types of caching: expiry-, validation-, and
invalidation-based caching. With Java portlets, you can combine invalidation-based
caching with either expiry-based or validation-based caching.

In addition to caching all your portlet's content, you can also cache fragments of your
portlets by using Edge Side Includes (ESI).

2.5.3 PL/SQL Portlets

Similar to Java portlets, PL/SQL portlets also support three types of caching: expiry-,
validation-, and invalidation-based caching.

2.6 Development Tool

This section describes development tools you can use to build different types of
portlets.

2.6.1 Web Clipping, OmniPortlet, and Portlet Builder

OmniPortlet, Web Clipping, and Portlet Builder use a browser-based wizard as the
development tool.

2.6.2 Java Portlets

Although you can use any Java development environment to build Java portlets, it is
highly recommended that you use Oracle JDeveloper, a professional, integrated
development environment (IDE). While you can consider other IDEs, the PDK
contains an Oracle JDeveloper plug-in that includes the Java Portlet Wizard, to
minimize your Java portlet development efforts.

The Java Portlet Wizard generates a starting skeleton and file structure for both JSR
168 and PDK-Java portlets. You need to add only your own business logic to the
skeleton. Oracle JDeveloper can also package and deploy your applications to your
J2EE container, such as Oracle WebLogic Server. Also, Oracle JDeveloper helps you
test your portlet provider. Oracle recommends that you use the preconfigured Oracle
WebLogic Server that is shipped withOracle JDeveloper as your development Java
portlet runtime environment, if the version matches that of the platform on which you
plan to deploy.

2.6.3 PL/SQL Portlets

When developing a PL/SQL portlet, you create PL/SQL program units that access
Oracle Portal by calling Oracle Portal PL/SQL APIs. To enable this access, you create a
schema, the provider schema, to store the provider and portlet PL/SQL packages in
the same database in which Oracle Portal is installed. The provider schema must be
granted execute privileges on the Oracle Portal PL/SQL APIs.
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To facilitate the development of database providers and PL/SQL portlets, you can use
the PL/SQL Generator, a hosted utility that creates installable PL/SQL code for a
database provider and its PL/SQL portlets. The PL/SQL Generator is a Web
application that receives the provider and portlet definitions in the form of an XML
file. The syntax of the XML tags that are used for the provider and portlet definition is
a subset of the XML tags that are used for defining Web providers with the PDK-Java.
The output of the PL/SQL Generator is a SQL script that can be run from SQL*Plus.
The script contains SQL commands for installing the provider and portlet packages.

The hosted PL/SQL Generator is available on the Oracle Portal Developer Kit page of

s
Maore On OTN:
OoTN

http://www.oracle.com/technology/products/ias/portal/pdk.html

2.7 Portlet Creation Style

Oracle Portal supports the following two types of portlet creation as shown in
Figure 2-5:

= Develop in-place
= Develop first, add later

The figure also indicates that the develop first, add later portlet creation is usually the
task of the portlet developer, while the develop in-place portlet creation is the page
designer's responsibility.

Figure 2-5 Portlet Creation Style
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2.7.1 OmniPortlet and Web Clipping

OmniPortlet and Web Clipping both offer a develop in-place portlet creation style.
First you add the portlets to a portal page and then you define them in place on the

page.

2.7.2 Java Portlets

Typically Java portlets offer a develop first, add later portlet creation style. Two
wizards are available through Oracle JDeveloper to assist with the creation of Oracle
PDK-Java and JSR 168 portlets. The wizards generate the basic files required for
portlet creation. The developer hand-codes the portlet logic. The development
sequence for Java portlets is to create the portlet, deploy it to a provider, register the
provider with Oracle Portal, and then add the portlet to a page.

Note: With extensive coding, you can create develop in-place Java
portlets. For example, Web Clipping and OmniPortlet are both Java
portlets.

2.7.3 Portlet Builder

With Portlet Builder you define the portlets first. The previously defined portlets are
then made available to you in the Portlet Repository so you can add them to your
pages. For simple portlets, though, Portlet Builder offers you the develop in-place
experience, similar to OmniPortlet and Web Clipping.

Note: Portlets built with Portlet Builder's develop in-place
technology are somewhat limited as compared to those built using the
Navigator.

2.7.4 PL/SQL Portlets

Similar to the Java portlets, PL/SQL portlets typically follow the develop first, add
later creation path. Extensive coding is required to develop in-place PL/SQL portlets.
For example, simple in-place portlets that are offered by Portlet Builder are written in
PL/SQL.

2.8 User Interface Flexibility

This section describes the portlet building tools in terms of the control you have over
the user interface.

2.8.1 Web Clipping

Because of its nature, Web Clipping always displays the remote Web site content,
therefore Ul flexibility is not a requirement for this portlet.

2.8.2 OmniPortlet

OmniPortlet enables you to use a number of different prebuilt layouts, such as
scrolling news, tabular, and chart. You can also use the built-in HTML layout to
personalize the look and feel of your portlet using HTML and JavaScript.
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2.8.3 Java Portlets and PL/SQL Portlets

In Java portlets and PL/SQL portlets, you have full control over your portlet's user
interface. Your portlet is free to generate any HTML content that conforms the
rendering rules for Oracle Portal pages.

2.8.4 Portlet Builder

While you can be very productive in building portlets with Portlet Builder, it is
somewhat limiting with respect to the user interface.

2.9 Ability to Capture Content from Web Sites

This section describes the portlet building tools in terms of their ability to include
content from other sources.

2.9.1 Web Clipping

For portlets that display content from a remote Web site as it is presented at the source
location, the best tool to use is Web Clipping. Web Clipping can tolerate the changes of
the source HTML page to some extent. If a clipped table moves from one place to
another in the source page, the Web Clipping engine can find the table again using the
internal "fuzzy match" algorithm. Portlets built with Web Clipping can also maintain
sessions to the remote Web sites. Web Clipping also supports end user personalization
of HTML form values.

2.9.2 OmniPortlet

For portlets using the data but not the layout from a remote Web site, the best choice is
OmniPortlet. Use OmniPortlet to retrieve the data, process the data (format, filter, and
so on), and present it in a portlet in a tabular, chart, or news format. OmniPortlet is a
powerful tool that extracts data from Web pages by using its Web page data source.

2.9.3 Java Portlets

Java portlets can take advantage of the low-level Java networking APIs to retrieve and
process content from remote Web sites. To avoid unnecessary development efforts,
before choosing Java always make sure that Web Clipping or OmniPortlet are not
viable options.

2.9.4 PL/SQL Portlets

PL/SQL portlets can communicate with Web servers to access data on the Internet by
using procedures and functions from the UTL_HTTP package. The package makes
HTTP callouts from SQL and PL/SQL. The package also supports HTTP over the
Secured Socket Layer protocol (SSL), also known as HTTPS, directly or through an
HTTP proxy. Other Internet-related data-access protocols (such as the File Transfer
Protocol (FIP) or the Gopher protocol) are also supported using an HTTP proxy server
that supports those protocols.

2.10 Ability to Render Content Inline

Active elements in your portlets, such as links or form buttons, enable your users to
navigate to remote URLs. In a News portlet, for example, you can click a hyperlink to
navigate to a news site with detailed information about news of interest. For example,
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a user clicks a news summary link in a News portlet, leaves the page, and lands on the
news site.

You may have a requirement to keep your users within the context of the portal page
by rendering the requested content within the same portlet container. For example, a
user clicks a news summary link in a News portlet, and the portlet refreshes with the
detailed news article.

2.10.1 Web Clipping

The Web Clipping portlet supports URL rewriting for achieving inline content
rendering. It can process the links originating from the source Web site and rewrite
them to achieve the desired functionality.

You can choose from the following three options:

= Select not to rewrite the URLS within the portlet, in which case clicking the links
takes users out of the portal to the Web site that provides the clipping. Whenever
the link brings the user to a place that requires authentication, the user must enter
login information before the link target is displayed.

s If the Web Clipping provider is registered with an External Application and the
clipping requires authentication, you can instruct Web Clipping to rewrite all
URLSs within the portlet to point to the Login Server. In this case, navigation will
cause the user to leave Oracle Portal, while also using the Login Server to log the
browser into the External Application.

= Select to rewrite all URLS within the portlet (inline rendering) to point back to the
portal page so that all browsing within the Web Clipping portlet remains within
Oracle Portal. If the Web Clipping provider is registered with an External
Application, this will cause the Web Clipping provider to log itself into the
External Application. In this case, the navigation within the portal through the
Web Clipping provider is authenticated in the External Application.

2.10.2 OmniPortlet

OmniPortlet does not offer URL rewriting directly, but you can achieve inline
rendering functionality by using public portlet parameters and events. Then you have
to map the events to the same portal page where your OmniPortlet resides.

2.10.3 Java Portlets

Since you have full control over the links and buttons in Java portlets, you can easily
implement inline rendering functionality. To achieve inline rendering, you must
append the private portlet parameters to the page URL.

If you use Struts in your portlet, the PDK-Struts integration framework renders your
content always in the same portlet container.

If your portlet consists of multiple JSPs (for example, several steps in a survey or
wizard), your portlet can make use of a special parameter to specify at run time the
JSP to use to render the content.

2.10.4 Portlet Builder

Portlets built with Portlet Builder do not have inherent inline rendering support. You
can, however, construct your links in SQL-based reports and charts so that they point
to specific portal pages. If required, you can also pass parameters to portal pages,
which in turn can be mapped to portlet parameters.

2-18 Oracle Fusion Middleware Developer's Guide for Oracle Portal



Public Portlet Parameters Support

2.10.5 PL/SQL Portlets

Similar to Java portlets, you have full control over the active elements in PL/SQL
portlets and, therefore, you can achieve the inline rendering functionality
programmatically by implementing private portlet parameters.

2.11 Charting Capability

This section describes the portlet building tools in terms of their charting functionality.

2.11.1 Web Clipping

Web Clipping clips pre-existing content. So, while it does not create charts, it can
retrieve and present HTML content that contains charts.

2.11.2 OmniPortlet

OmniPortlet supports bar, line, and pie charts. Charts in OmniPortlet are dynamically
generated images, which can include hyperlinks.

2.11.3 Java Portlets

You can create sophisticated chart portlets programmatically in your Java portlets
using Oracle's Business Intelligence (BI) Beans.

Note: Oracle Reports and Oracle BI Discoverer portlets use BI Beans
to create professional graphs.

2.11.4 Portlet Builder

With Portlet Builder, you can build HTML-based bar chart portlets. Among other
features, you can specify the color and orientation of the bars.

2.11.5 PL/SQL Portlets
In PL/SQL portlets, HTML-based charting can be achieved by extensive coding.

2.12 Public Portlet Parameters Support

There are three types of parameters in Oracle Portal: page parameters, public portlet
parameters, and private portlet parameters. These parameters can be described as
follows:

= Page parameters: You can use a page parameter to pass a value to a page. Using
page parameters, the information that is displayed on a page can vary depending
on where the page is called from and who is viewing the page. Using page
parameters, page designers can synchronize the portlets on a page by passing
them the same values. This provides the ability to reuse and tailor portlets on
pages by merely integrating them with page parameters. Without this
functionality, you would have to code portlets individually to use different
parameter values.

»  Public portlet parameters: You can use a public portlet parameter to pass a value
to a portlet. Using portlet parameters, the information that is displayed in a portlet
can be specific to a particular page or a user. Portlet parameters are created by the
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portlet developer and are exposed to the page designer, through the user interface.
After adding a portlet to a page, page designers can assign values to the public
portlet parameters to make the information displayed in the portlet specific to the
page.

Page designers can assign values to public portlet parameters by providing a
specific value (constant), a system variable (for example, the portal user name), or
a page parameter. At run time, the portlet receives the values from the sources
specified. In this way, page designers have complete control over the source of the
parameter, whereas you have complete control over how the data is used after it is
transmitted to the portlet.

s Private portlet parameters: You can use private portlet parameters to implement
internal navigation in your portlet. You can pass parameters to your portlets every
time the page is requested. Private portlet parameters can be passed exclusively
from the portlet instance to the same portlet instance.

Private portlet parameters do not require a full page refresh. You can create a link
in a portlet that can be used to refresh the portlet only, without triggering a full
portal page refresh. By doing this, only the content of the affected portlet is
updated and the rest of the page is not. Refer to "Partial Page Refresh" in

Chapter 7, "Enhancing Java Portlets" for details about setting this
programmatically.

Portlets supporting public portlet parameters enable page designers to tailor the
portlets' data input for each portlet instance. In this case, the portlet developer can
focus on the portlet logic, while page designers can easily reuse portlets and address
the interaction between the page and the portlets.

All five portlet building technologies discussed in this chapter (OmniPortlet, Web
Clipping, Java portlets, Portlet Builder, and PL/SQL portlets) support public portlet
parameters. OmniPortlet, Web Clipping, and Portlet Builder provide complete support
through their wizard interface. You can add public portlet parameter support to your
Java portlets programmatically or with the Java Portlet Wizard. PL/SQL portlets
support public parameters only programmatically.

Note: The JSR 168 standard does not cover the notion of public
portlet parameters. If you want to utilize public portlet parameters in
your Java portlets, you have to use PDK-Java.

2.13 Private Portlet Parameter Support

This section describes the portlet building tools in terms of their support for private
parameters.

2.13.1 OmniPortlet, Web Clipping, and Portlet Builder

OmniPortlet, Web Clipping, and Portlet Builder do not provide access to the portlet
developer to private portlet parameters.

2.13.2 Java Portlets and PL/SQL Portlets

In your Java portlets and PL/SQL portlets, you can implement internal navigation by
using private portlet parameters.
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Note: PL/SQL portlets do not support private and public
parameters simultaneously. You need to decide which parameter type
to support before coding your PL/SQL portlet.

2.14 Event Support

An event is a user action that you define to display a Portal page. User actions include
clicking a link or a button in a portlet. Page designers specify what to do when an
event occurs in a portlet on a page. When an event occurs, page designers can either
redisplay the current page or navigate the user to another portal page, optionally
passing values to that page's parameters.

2.14.1 Web Clipping, OmniPortlet, and Java Portlets
Web Clipping, OmniPortlet, and Java portlets support events.

2.14.2 Portlet Builder and PL/SQL Portlets
Portlet Builder and PL/SQL portlets do not support events.

2.15 Ability to Hide and Show Portlets Based on User Privileges

This section describes the portlet building tools in terms of their support for
authorization functionality.

2.15.1 Web Clipping and OmniPortlet

You can hide and show portlets built with Web Clipping and OmniPortlet on portal
pages dynamically by using security managers. Although Web Clipping and
OmniPortlet do not expose security managers through the user interface, you can
apply them by editing their XML provider definition file.

2.15.2 Java Portlets

The PDK provides a number of security managers for Java portlets. Following are two
examples:

= Group security manager: The group security manager makes the portlet appear to
users who are members of a specified group, while hiding it from those who are
not members.

= Authentication level security manager: You can use the authentication level
security manager to control access to the portlets based on the user's
authentication level. For example you may hide the portlet from public users but
display it to authenticated users.

JSR 168 portlets support the standard servlet mechanisms.

2.15.3 Portlet Builder

Portlet Builder provides a declarative user interface to control access to portlets.
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2.15.4 PL/SQL Portlets

The PDK provides security APIs to implement hiding and showing content in PL/SQL
portlets.

2.16 Multilingual Support

This section describes the portlet building tools in terms of their support for other
languages.

2.16.1 Web Clipping, OmniPortlet, Java Portlets, and PL/SQL Portlets

Web Clipping, OmniPortlet, Java portlets, and PL/SQL portlets display textual
information in the language selected by the portal user.

2.16.2 Portlet Builder
Portlets built with Portlet Builder support English only.

2.17 Pagination Support

Support for pagination is useful when a portlet must display a relatively large set of
records.

2.17.1 Web Clipping
Pagination support is not applicable to Web Clipping.

2.17.2 OmniPortlet

OmniPortlet does not support pagination.

2.17.3 Java Portlets and PL/SQL Portlets

You can implement pagination in your Java portlets and PL/SQL portlets
programmatically.

2.17.4 Portlet Builder

Portlet Builder has built-in support for pagination.

2.18 Single Sign-On and External Application Integration

This section describes the portlet building tools in terms of authentication for external
application.

2.18.1 Web Clipping

Web Clipping's integration with the external application framework provides a fully
automated mechanism to store passwords to external Web sites. All you have to do is
to associate an External Application ID to the Web Clipping provider when registering
the provider.
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2.18.2 OmniPortlet

OmniPortlet enables you to store connection information when the data source is
password protected. The credentials to access the data source can either be shared
across all users, or saved individually for each user. OmniPortlet is capable of storing
database credentials, as well as HTTP basic authentication user name-password pairs.
The credentials are stored in the secured data repository of OmniPortlet, in an Oracle
database.

2.18.3 Java Portlets

Java portlets support programmatic integration with the external application
framework as well as any LDAP server, such as Oracle Internet Directory.

2.18.4 PL/SQL Portlets

You can build PL/SQL portlets that enable single sign-on by using mod_osso, an
authentication module on the Oracle HTTP Server. mod_osso is a simple alternative to
the single sign-on SDK, used in earlier releases to integrate partner applications. mod_
osso simplifies the authentication process by serving as the sole partner application to
the Single Sign-On server.

PL/SQL portlets can integrate with the external application framework
programmatically.
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Creating Portlets

Part II contains the following chapters:

Chapter 3, "Creating Portlets with OmniPortlet"

Chapter 4, "Building Example Portlets with OmniPortlet"
Chapter 5, "Creating Content-Based Portlets with Web Clipping"
Chapter 6, "Creating Java Portlets"

Chapter 7, "Enhancing Java Portlets"

Chapter 8, "Creating PL/SQL Portlets"






3

Creating Portlets with OmniPortlet

This chapter provides an overview of OmniPortlet and explains the user interface
elements associated with OmniPortlet. This chapter contains the following sections:

s Section 3.1, "Introduction to OmniPortlet"
s Section 3.2, "The OmniPortlet Wizard"
s Section 3.3, "Parameters and Events"

For information about using OmniPortlet to build example portlets, see Chapter 4,
"Building Example Portlets with OmniPortlet." For troubleshooting information
regarding OmniPortlet, see Section B.3, "Diagnosing OmniPortlet Problems." For
information about registering and configuring OmniPortlet with Oracle Portal, see
Oracle Fusion Middleware Administrator’s Guide for Oracle Portal.

3.1 Introduction to OmniPortlet

OmniPortlet is a subcomponent of Oracle Portal that enables page designers and
developers to easily publish data from various data sources using a variety of layouts
without writing any code. You can base an OmniPortlet on almost any kind of data
source, such as a spreadsheet (character-separated values), XML, and even application
data from an existing Web page.

Note: You can find more information about developing different
types of portlets in Chapter 1, "Understanding Portlets," and
information about providers and other portlet technologies in
Chapter 2, "Portlet Technologies Matrix."

OmniPortlet enables page designers and content contributors to do the following:
= Display data from multiple sources (CSV, XML, SQL, and so on)

= Sort the data to display

= Format data using a variety of layouts (bulleted list, chart, HTML, and so on)
= Use portlet parameters

= Raise portlet events

= Expose personalizable settings to page viewers

To display personalized data, you can refine the retrieved data by filtering the results
returned from a data source, and parameterize the credential information used to
access secure data. Out of the box, OmniPortlet provides the most common layout for
portlets: tabular, chart, HTML, news, bulleted list, and form.
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Note: To use OmniPortlet, the Simple Parameter Form, or the
Web Clipping portlet with Windows 2000, you must use Netscape
7.0 or later, or Microsoft Internet Explorer 5.5 or later.

You can add an OmniPortlet to a portal page just as you would add any other portlet.
OmniPortlet can be found under Portlet Builders in the Portlet Repository. If you have
downloaded OmniPortlet as part of the Oracle Portal Developer Kit, for example, to
upgrade to a later release, you must register it before you can use it.

You can find more information about building portal pages and adding portlets in
Oracle Fusion Middleware User’s Guide for Oracle Portal.

Instructions for installing, configuring, and registering the OmniPortlet provider are
provided within the pdksoftware. zip file containing the PDK-Java and Portal
Tools. For specific information on configuring OmniPortlet, see Oracle Fusion
Middleware Administrator’s Guide for Oracle Portal.

3.2 The OmniPortlet Wizard

The OmniPortlet Wizard initially contains five steps. When you first define your
OmniPortlet, you set the data source type, data source options, filter options, view
options, and layout. When you've completed these steps of the wizard, you can
re-enter the wizard by clicking Edit Defaults for the portlet. When you re-enter the
wizard, you can change the definitions on the Source, Filter, View, and Layout tabs, as
well as set up the event parameters on the Events tab.

Note: On the IBM Linux on Power platform, if the action buttons
(Next, Previous, Finish, and Cancel) are minimized to dots when
defining the OmniPortlet, increase the stack size shell limit to
unlimited and restart the WLS_PORTAL instance. Run the following
command to set the stack size shell limit to unlimited:

prompt> ulimit -s unlimited

This section provides a high-level overview of the six tabs, which are described in
Table 3-1. You can also find information in the online Help (accessible by clicking the
Help link in the product), which describes the options on each tab.

Table 3-1 OmniPortlet Wizard and Edit Defaults

Step/Tab Description

Type Provides your data source options. Displays only in the initial
definition of the portlet, and is not available when editing the
defaults of the portlet.

Source Provides the options for the selected data source, such as the

URL of the Web Service you want to use. You can change these
options later when editing the defaults of the portlet.

Filter Provides sorting options at the Oracle Portal level to enable
you to refine your results. You can change these options later
when editing the defaults of the portlet.

View Provides options for displaying portlet header and footer text,
the layout style, and caching. You can change these options
later when editing the defaults of the portlet.
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3.2.1 Type

Table 3—-1 (Cont.) OmniPortlet Wizard and Edit Defaults

Step/Tab Description

Layout Provides detailed options for customizing the layout. You can
change these options later when editing the defaults of the
portlet.

Events Does not display in the initial definition of the portlet. Provides

options for adding events to the portlet. Displays only after the
portlet has been defined in the Edit Defaults mode of the
wizard.

When you first start OmniPortlet, the Type step displays, which enables you to choose
your data source (Figure 3-1). Out of the box, OmniPortlet supports the data sources
shown in Table 3-2.

Figure 3—1 Type Tab of the OmniPortlet Wizard

. " ' '
L - s
Tvpe Source Filter  “iew  Layout

@ Spreadsheet - A text file with character separated values (CSW)
30U

ML

 Web Senice

" Weh Page - Use existing web content as a source of data

Note: If you've downloaded and installed an additional data
source, the data source will display on the Type tab.

Table 3-2 Supported Data Source Types

Data Source Type Description

Spreadsheet Displays data from a text file containing character-separated
values (CSV).

SQL Displays data from a database using SQL.

XML Displays data from an XML file.

Web Service Displays data from a discrete business service that can be

accessed over the Internet using standard protocols.

Web Page Displays data based on existing Web content.
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3.2.2 Source

Table 3-2 (Cont.) Supported Data Source Types

Data Source Type Description
J2EE Connector (Displays only if the Sample Provider is registered with Oracle
Architecture* Portal). A J2EE Connector Architecture (JCA) 1.0 adapter is

also available. JCA provides a mechanism to store and retrieve
enterprise data such as that held in ERP systems (Oracle
Financials, SAP, PeopleSoft, and so on).

After you complete the OmniPortlet Wizard and edit the defaults of the portlet, you
cannot change the data source type.

After you've chosen your data source type, the Source step of the OmniPortlet Wizard
displays. This step adapts to the data source you've chosen, enabling you to specify
the options offered by that data source. The Source tab contains a Proxy
Authentication section if the OmniPortlet provider has been configured to use a proxy
server requiring authentication, and a Connection section where you can provide the
necessary information for connecting to the data source.

This section contains information about the following two common areas on the
Source tab:

= Section 3.2.2.1, "Proxy Authentication"
s Section 3.2.2.2, "Connection Information"

Later, this section also describes the portion of the Source tab specific to each data
source. The data sources available are as follows:

»  Section 3.2.2.3, "Spreadsheet"
= Section 3.2.2.4, "SQL"

= Section 3.2.2.5, "XML"

m  Section 3.2.2.6, "Web Service"
= Section 3.2.2.7, "Web Page"

Note: For more information on the Source tab options, click Help
in the upper right corner of the page.

3.2.2.1 Proxy Authentication

OmniPortlet supports proxy authentication, including support for global proxy
authentication and authentication for each user. You can specify whether all users will
automatically log in using a user name and password you provide, each user will log
in using an individual user name and password, or all users will log in using a
specified user name and password. If the OmniPortlet provider has been set up to use
proxy authentication that requires your login, a Proxy Authentication section displays
on the Source tab where you can enter this information.

The Proxy Authentication section only displays for the data sources that may require
you to use a proxy server to access them: CSV (character-separated values), XML, Web
Service, and Web Page. For more information on configuring the OmniPortlet
provider to use proxy authentication, see the online Help topic that displays when you
click Help on the Edit Providers: OmniPortlet Provider page. If the OmniPortlet
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provider is configured to "Require login for all users," each user must set his or her
own login information:

- For page designers, set this in Edit Defaults: Source tab.
- For page viewers, set this on the Personalize screen.

You can also find more information on configuring OmniPortlet in Oracle Fusion
Middleware Administrator’s Guide for Oracle Portal.

Note: If you are using the Web Page data source, the Proxy
Authentication section displays in the Web Clipping Studio, after
you have clicked the Select Web Page button on the Source tab.

3.2.2.2 Connection Information

For each data source except the Web Page data source, the Source step contains a
Connection section, where you can define the connection information to access
secured data. The Source step for all data sources includes a Portlet Parameters
section, where you can define the parameters for the portlet (Figure 3-2). You can then
map the portlet parameters to the page-level parameters.

Note: If you use parameters in place of Username, Password, or
Connection String, the Test button will return an error, however the
connection information is correct when the parameter values are
substituted.

Figure 3-2 Source Tab: Connection and Portlet Parameters Section

Connection
To access secured data, you will need to provide connection information to the data source.

Connection Information  =Mone= | Edit Cennection )

' Use this connection information for all users
€ User must re-enter connection infarmation
Portlet Parameters
Parameters are passed to the portlet from the page when the portletis displaved. These parameters can be mapped to page level parameters by editing the Page Properties

Parameter Name Default Value Customizable Customize Page Label Customize Page Description
Param1 — r Param1 Description for Parameter 1
Param2 r Param?2 Description for Parameter 2
Param3 r Param3 Description for Parameter 3
Param4 r Paramd Description for Parameter 4
Params r Params5 Description for Parameter 5

To edit the connection information, click the Edit Connection button and fill out the
information on the page shown in Figure 3-3. On this page, you can enter a name for
the connection information, as well as the user name and password. For the SQL data
source, you can enter more information to specify the driver you wish to use to
connect to the data source. For more information, see Section 3.2.2.4, "SQL."

Figure 3-3 Edit Connection Page

Connection Mame I o,}?

¥ Make this named connection available to all users.

Personalizable
Usemame v

Passward v
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Note: For more information about the Connection section and the
Edit Connection button, click Help on the Source tab of the
OmniPortlet wizard.

3.2.2.3 Spreadsheet

Spreadsheets are a common method of storing small data sets. OmniPortlet enables
you to share spreadsheets by supporting character-separated values (CSV) as a data
source. On the Source tab, you specify the location of the CSV file (Figure 3-4). If the
file is located on a secure server, you can specify the connection information in the
Connection section described in Figure 3-2. You can also select the character set to use
when Oracle Portal reads the file, as well as the delimiter and text qualifier.

Since the OmniPortlet provider exists and executes in a tier different from the Oracle
Portal application and does not have access to the Oracle Portal session information,
you must expose CSV files that are uploaded to Oracle Portal as PUBLIC in order for
OmniPortlet to access them.

Note: For more information on using the CSV data source, see
Section 4.3, "Building an OmniPortlet Based on a Spreadsheet
(CSV)."

Figure 3—-4 Source Tab: Spreadsheet

| a8Y /
G
{97 ol

CEY URL IfhtdocsfomniF'orﬂetfsampleData.-’emponees.csv

W Use first row of spreadsheet for column names

Delimiter IComma 'l I Text Qualifier I" Vl

CSV Character Set Encoding | Unicode(UTF-8) |

3.2.2.4 SQL

The relational database is the most common place to store data. OmniPortlet enables
you to use standard JDBC drivers and provides out-of-the-box access to Oracle and
any JDBC database. You can specify the driver type when you configure the
connection information. Figure 3-5 shows the Source tab for a SQL data source.

3-6 Oracle Fusion Middleware Developer's Guide for Oracle Portal



The OmniPortlet Wizard

Figure 3-5 Source Tab: SQL

select * fram emp ;l

Staterment

[ |

& TIP vou can use ##ParambEE (e #3F aram 138 in place of any text in the SOL Query. You can also
use wvariahle (ex: deptno = p_dept) to define hind variables. Leath more...

| Show Bind Variables) [ Test)

3.2.2.4.1 SQL Connection Information You can use the DataDirect JDBC drivers to access
other relational databases. To configure OmniPortlet to use these drivers, see Oracle
Fusion Middleware Administrator’s Guide for Oracle Portal.

After the driver is installed, you'll notice it listed in the Driver Name list on the
Connection dialog box on the Source tab, as shown in Figure 3-6.

Figure 3-6 Connection Information on the SQL Source Tab

Parameters
Personalizable

Username

Password

Connection String |

Driver Name | Oracle-thin v

Test

& TIP You can use the format ##Parami## (ex : ##Param1##) in place of Username, Password or Connection String. Sample Username, Password and Connection String would be "scott”, "tiger" and
"mymachine:1521:iasdb" respectively. Learn more...
& TIP The Connection String format depends on the driver chosen. For "Oracle-thin" driver, the format is Host:Port:SID. Learn more...

EEREF

Note: For more information on DataDirect drivers, see the
Certification Matrix for Oracle Fusion Middleware and DataDirect [DBC
(http://www.oracle.com/technology/products/index.h
tml).

When you want to use one of the DataDirect drivers, you must use a unique
connection string format: hostname : port, where hostname is the name of the server
where the database is running, and port is the listening port of the database. You can
see an example in Figure 3-7.

Figure 3—7 Edit Connection Page with DataDirect Driver

Parameters

Username
Password
Connection String ‘
Driver Name | Oradle-thin v
(Test)
@ TIP You can use the format ##ParamN## (ex : ##Paraml##) in place of Username, Password or Connection String. Sample Username, Password and Connection String would be "scott”, "tiger" and

"mymachine:1521:iasdb" respectively. Learn more...
& TIP The Connection String format depends on the driver chosen. For "Oracle-thin" driver, the format is Host:Port:SID. Learn more...
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3.2.2.4.2 Using Stored Procedures You can also make a call to Stored Procedures instead
of SQL statements to add business logic to your data. You can create your package and
stored procedure in your database and refer the stored procedure in OmniPortlet.

For example, you could do the following using the SCOTT sample schema:
1. Create a package and declare a ref cursor:

create or replace package emp_pack is
type empcurr is ref cursor;
end;

2. Define a stored procedure, for example the following procedure accepts JOB as a
parameter and returns a ref cursor, where JOB Column in the scott.Emp table,
its value can be CLERK, MANAGER, and so on.

create or replace procedure emp_proc (eset OUT emp_pack.empcurr,
jname IN VARCHAR2)

is

sgl_statement varchar2 (200);

begin

sqgl_statement := 'select empno,ename,hiredate
from emp

where job = '''||jname||' "’

order by EMPNO,hiredate';
open eset for sqgl_statement;
end;

3. Add the PL/SQL statements from steps 1 and 2 to a SQL file (for example,
proc.sqgl) and save it to a directory.

4. Connect to the database using the following command:
sqglplus userid/password@Connection_String
Replace userid, password, and Connection_String with the connection

information to your database. You can find the connection string in the
tnsnames . ora file within your ORACLE_INSTANCE\config directory.

5. Run the procedure:
@proc
6. Finally, create an OmniPortlet based on the SQL data source, enter the appropriate

database connection information. In the SQL Statement box, enter the following
code:

call emp_proc('CLERK')

3.2.2.5 XML

You can access XML data sources across the intranet or Internet. On the Source tab,
you can specify the URL of the XML file that contains your data as shown in
Figure 3-8.

Note: For more information on using the XML data source, see
Section 4.4, "Building an OmniPortlet Based on an XML Data
Source."
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Figure 3-8 Source Tab: XML

ML URL |fhtdocsf0mniF'0rtIetfsampIeDatafdepanments.xml [ Test)

Optionally enter an XSL filter to transform the data
This is useful when the data is not in <ROVWSET=/<ROW= format.

el .
Filter | Test
URL

Optionally enter an XML Schema to describe the data
This is useful when your XML data doesn't have data for all fields, or to override what is defined in the XML data.

#ML Schema
LRL

Next to the XML URL and the XSL Filter URL fields are Test buttons which you can
use to validate your XML data source and the XSL filter.

The specified XML file can either be in tabular (ROWSET /ROW) structure, or you can
provide an XML Style Sheet (XSL) to transform the data into the ROWSET/ROW
structure. The following example shows the ROWSET /ROW structure of an XML data
source.

<TEAM>
<EMPLOYEE>
<DEPTNO>10</DEPTNO>
<ENAME>KING</ENAME>
<JOB>PRESIDENT</JOB>
<SAL>5000</SAL>
</EMPLOYEE>
<DEPTNO>20</DEPTNO>
<ENAME>SCOTT</ENAME>
<JOB>ANALYST</JOB>
<SAL>3000</SAL>
<EMPLOYEE>
</TEAM>

In this example, the <TEAM> tags delineate the rowset, and the <EMPLOYEE> tags
delineate the rows.

Regardless of the format of the XML file, OmniPortlet automatically inspects the XML
to determine the column names, which will then be used to define the layout. If you
want to specify this information yourself, you can supply a URL to an XML schema
that describes the data.

Similar to the other data sources, you can also specify the connection information for
this data source, if the XML file is located on a secured server protected by HTTP Basic
Authentication.

Note: Since the OmniPortlet provider exists and executes in a
different tier from Oracle Portal and does not have access to the
Oracle Portal session information, you must expose XML files that
are uploaded to Oracle Portal as PUBLIC in order for OmniPortlet
to access them.

3.2.2.6 Web Service

A Web Service is a discrete business service that can be programmatically accessed
over the Internet using standard protocols, such as SOAP and HTTP. Web Services are
not specific to a platform or language, and are typically registered with a Web Service
broker. When you find a Web Service you want to use, you must obtain the URL to the
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Web Service Description Language (WSDL) file that describes the Web Service and
specifies the methods that can be called, the expected parameters, and a description of
the returned data.

OmniPortlet supports both types of Web Services: Document and RPC (Remote
Procedure Calls). After a WSDL document/file is supplied, it is parsed, and the
available methods that can be called display on the Source tab.

Similar to the XML data source, OmniPortlet expects the Web Service data in
ROWSET/ROW format, though you can also use an XSL file to transform the data.
OmniPortlet inspects the WSDL document/file to determine the column names,
though you may also specify an XML schema to describe the returned data set.

Figure 3-9 shows the Source tab for a Web service.

Note: For more information on using the Web Service data source,
see Section 4.2, "Building an OmniPortlet Based on a Web Service."

Figure 3-9 Source Tab: Web Service

.WL /

L

WSDLURL  |http:/fotn.oracle. cormdwsforacle. otn.ws. scott. OTNDeptEmp?Wws0L Show Methods )
Weh Service Methads
Availahle methods for this ¥web Service W Shaow Parameters )
Enter values for the method parameters
This method does not take any parameters &)

@ TIP You can use the farmat ##Paramhi (e #Param1##) to pass data from the page into the method parameters. Learn more

Optionally enter an XSL filter to transform the method output
This is useful when the data is notin <ROWSET=/<ROW= format

XL Filter URL. [ (Test)

Optionally enter an XML Schema to describe the method output
This is useful when the XML data doesnt have data for all figlds or o override what is defined in the XML data

XML Schema URL |

@ TIP ¥ou can use the format ##F aram i (e ##Param 13 to pass data from the page inta the URLS. Learn mare...

3.2.2.7 Web Page

OmniPortlet enables you to use existing Web content as a source of data to publish
information to your portal. It provides and renders clipped Web content as a data
source.

The Web Page data source extends the scope offered by the Web Clipping Portlet to
include scraping functionality. It also supports the following features:

= Navigation through various login mechanisms, including form- and
JavaScript-based submission, and HTTP Basic and Digest Authentication with
cookie-based session management.

»  Fuzzy matching of clippings. If a Web clipping gets reordered within the source
page or if its character font, size, or style changes, it will still be identified correctly
by the Web page data source and delivered as the portlet content.

= Reuse of a wide range of Web content, including basic support of pages written
with HTML 4.0.1 and JavaScript, retrieved through HTTP GET and POST (form
submission).

All Web clipping definitions are stored persistently in the Oracle Fusion Middleware
infrastructure database or on another Oracle database. Any secure information, such
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3.2.3 Filter

as passwords, is stored in encrypted form, according to the DES (Data Encryption
Standard), using Oracle Database encryption technology.

The Source tab of the OmniPortlet Wizard (Figure 3-10) enables you to start the Web
Clipping Studio by clicking the Select Web Page button. Once you start the Web

Clipping Studio, you can see the Oracle Fusion Middleware Web Clipping online
Help.

Note: For more information on using the Web Page data source,
see Section 4.5, "Building an OmniPortlet Based on a Web Page
Data Source."

Figure 3—-10 Source Tab: Web Page

Web Page

You can use a web page as a data source. When the portlet is displayed, data is extracted from the web page. Any changes to the data on the web page are automatically
reflected in the portlet

Select the web page and identify an area (clipping) of the page to use as data

( Select Web Pags )

Portlet Parameters

Parareters are passed to the portlet from the page when the portlet is displayed. These parameters can be mapped to page level parameters by editing the Page
Properties

Parameter Name Default Value  Custemizable Custemize Page Label Customize Page Description

Param1 - Param1 Description for Parar
Paramz - Param2 Description for Parar
Param3 - Param3 Description for Parar
Param4 - Param4 Description for Parar
Params - Params Description for Parar

After you've selected the data source and specified the data source options, you can
further refine your data by using OmniPortlet's filtering options. To use filtering
efficiently, it is better to refine the data as much as possible at the data source level on
the Source tab, then use the options on the Filter tab to streamline the data. For
example, if you are using a SQL data source, you could use a WHERE clause to return
only specific data from the specified columns. In this case, you could skip the Filter tab
and continue to the View page of the wizard. However, if there are no filtering options
at the data source level, you can use the options on the Filter tab to sort your data
(Figure 3-11).

Figure 3—11 Filter Tab

Filter
Use this page to filter and order the data that appears in your portlet.

Conditions
Specify the conditions that the data must meet in order to appear in your portlet. Click the plus sign to specify conditions for additional columns.

@ Match all © Match any
Celumn Operator Value Actions
[<Mane> =] [Contains I *

@ TIP Vou can use the format ##Faramhli# (ex: ##Param1##) to pass data from the page into the Value. Leam more

Order
Determine how the data should be ordered
Column Order
Order by [ <None> =] [Ascending =]
Then by |<None> lescendmg j
Then by [<None> =] [Ascending =]

Limit
If desired, limit the number of rows that appear in the portlet

& Da nat limit results

© Limit to results
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3.24 View

3.2.5 Layout

Once you've specified the data and sorted it, you can choose the view options and
layout for your OmniPortlet. The View tab (Figure 3-12) enables you to add Header
and Footer text, choose a Layout style that you can later refine on the Layout tab, and
enable caching. You can choose from the following layouts:

s Tabular

n  Chart
»  News
»  Bullet
» Form
= HTML

Figure 3-12 View Tab

Tite  |OrnniPartlet

Header Text

¥ Show Header Taxt

Footer Text

Ll

[¥ Show Footer Text

& TIP You can use the Tormat 3P aramiEs (ex #HParam 139 10 pass data frorm the page into the texd, and ##Calurnn Narmeds (ex #FDEFTN
the text. Leam rore...

Layout Style
Select a layout for the portlet data.

& Tabular Data View Customize Help About ¥
fa Sample Data.
Chat Column1 Column2 Column3
C Mews Kathleen Bayyat President - Manufacturing 100000
© Bullet Robert Redriguz President - Sales 100000
Edward Shields Chief Financial Officer 100000
i Farm Jan Francoig Stewart Graphic Artist 36000

Lisa Wiliams Graphic Artist 36000
Sandra Kyte Course Developer 54000
Eaule Yau Customer Sales Rep ive 39000

Caching
If page level caching is not used, then the page will always have to wait for this portlet to generate ifthe portletis not cached. This can adversely

& Cache the Portlet Content for IBD minutes
' Dont Cache the Portlet Content

Note: For more information on the different layout styles you can
use with OmniPortlet, see the next section or click Help in the
upper right corner of the page in the OmniPortlet Wizard.

The Layout tab changes depending on the Layout Style you chose on the View tab,
and enables you to further personalize the appearance of your portlet. For example,
OmniPortlet supports drill-down hyperlinks in the chart layout. That is, you can set
up the chart so that when a user clicks on a specific part of the chart, an action occurs
(for example, jump to another URL).

For the other layout styles, you can define each column to display in a specific format,
such as plain text, HTML, an image, button, or field. For example, suppose you
selected a data source that includes a URL to an image. To see this image, you can
select Image for the display of this column. Each column can also be mapped to an
action, similar to the behavior of chart hyperlinks.
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The following layout styles are available with OmniPortlet:
»  Section 3.2.5.1, "Tabular Layout"

s Section 3.2.5.2, "Chart Layout"

= Section 3.2.5.3, "News Layout"

= Section 3.2.5.4, "Bullet Layout"

»  Section 3.2.5.5, "Form Layout"

s Section 3.2.5.6, "HTML Layout"

3.2.5.1 Tabular Layout

Once you've chosen the tabular style on the View tab, you can refine the layout on the
Layout tab (Figure 3-13). Typically, you use the tabular layout if you have one or more
columns of data that you want to display in a table. You can choose Plain to display all
rows in the table without any background color, or Alternating to display a
background color for every other row in the table.

Figure 3-13 Layout Tab: Tabular Style

" Plain Data View Customiza Halp About T

& Alternating | Sample Data.
AN ¢ olumn Column2

President - Manufacturing
President - Sales
Chiaf Financial Officer

Sandra Kyte Course Developer 54000
Eaulo Yau Customer Sales Representative 39000

ay in the table
Name Column Label Column Alignment  Display As  Action URL s\lﬁ)s(':‘)l::’"ew
Field1 |emp\oyeejd |emp|ayeeild =l |Leﬂ =l |Tem =l |<None> =l | [l
Field2 |Name |Name =l |Leﬂ =l |Tem =l |<None> =l | [l
Fieldd [Gender [ender =l Jeet =] [Test =] [emones =] )
Fieldd [Job [Job =l Jeet =] [Test =] [emones =] r
Fields [Email [Email =l Jeet =] [Test =] [emones =] )

Note: You can control the background color of a portlet through
the portal page style. For more information on using portal page
styles, see Oracle Fusion Middleware User's Guide for Oracle Portal.

In the Column Layout section, you can choose which data columns to display in the
portlet, then select a display format for the data. Here, you can set a column to display
a hyperlink, so that a secondary Web page displays when the user clicks that column
in the table. You can also specify whether the secondary Web page displays in a new
window. Figure 3-14 shows an example of an OmniPortlet using a tabular format.

Figure 3—-14 Example of an OmniPortlet Using a Tabular Layout

Web Service portlet Customize
ist of employees of the RESEARCH department.

MPNO ENAME JOB MGR HIREDATE
a7e ADAMS CLERK. 7raa 1957-05-23
a0z FORD ANALYET Ta6E 1981-12-03
bt JOMES MAMAGER T34 1851 -04-02
788 SCOTT ANALYST 7566 1957-04-19
369 SMITH CLERK. a0z 1980-12-17
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Note: For more information on using the OmniPortlet Wizard,
click the Help link in the upper right corner of the Layout tab.

3.2.5.2 Chart Layout

You can use the chart layout to display your data graphically, as a bar, pie, or line
chart. On the Layout tab (Figure 3-15), you select the chart style and the column
layout. When you choose the column layout, you can choose the groups, or columns
on which the labels will be based. The category defines the values that will be used to
create the chart legend, and the value determines the relative size of the bars, lines, or
slices in the chart. You can also select whether the sections of the chart should point to
a hyperlink, and whether the targeted information should display in a new window.
Figure 3-16 shows an example of the Layout tab for a pie chart layout.

Figure 3—15 Layout Tab: Chart

Chart Style

[Of:E'3 Data View Customiza Help About T *
{'pjg |Sample Data
C Line

<Category=

B Ffres

o Chief

= Graphic
o Course
Bales

10 B 40

Width (300 pivels
Height {300 pivels

Legend | <Monex =
[0 3D Effect
Column Layout
Select the columns to disglay in the chart
Column
Group |=<MNone= x|
Categary | City i
Valug |Population ¥
Chart Drilldown
Select the action that will occur when the user clicks on the bar, pie slice or line.
. Open In New
Action URL Window
[<none> x| | r

Note: To group the information in the chart, you must group the
information at the data level (for example, in your SQL query
statement). Also, if numeric values in a data source contain
formatted strings, commas, or currency (for example, $32,789.00),
they are considered to be text and ignored when the chart is
generated. You should remove these formatting characters if you
want them to be correctly read as numerical values.

3-14 Oracle Fusion Middleware Developer's Guide for Oracle Portal



The OmniPortlet Wizard

Figure 3-16 Example of the Layout Tab for a Pie Chart Layout

Chart Style

 Bar Data View Customize Help About T *
@ pjg  |Sample Data.
C Line

<Category>

aFres

a Chief

a Graphic
Col

azales

Width |300 pixels
Height |300 pixels

Legend [<None» =

[T 3D Effect

Column Layout
Select the columns to display in the chart.

Column

Group [ <None>

Category | City

[ER[ER(E!

Walue | Population
Chart Drilldown
Select the action that will occur when the user clicks on the bar, pie slice or line

Open In New

Action URL Window

[<hone= =] | r

You can also define chart hyperlinks so that each bar, pie section, or line links to
another Web page. For example, you can display a chart portlet and a report portlet on
your portal page, then set up the chart hyperlink to display a row in the report that
displays more detailed information about the selected data.

In Figure 3-17, you can see an example of a pie chart. Below the chart, you can see that
the category, Department, is used for the legend.

Figure 3—-17 Example of an OmniPortlet Using a Pie Chart Layout

32 398 30148

T4TH

[l ACCOUNTING [] RESEARCH  [] SALES

3.2.5.3 News Layout

You can use the news layout to display links to articles with brief descriptions for
each. You can use this layout to publish information in standard XML formats, such as
RDF (Resource Description Framework) or RSS (RDF Site Summary) to your portal
page. In the Column Layout section (Figure 3-18), you can add a heading that displays
at the top of the portlet. You can also add a logo, or use the scrolling layout so that the
user can view all the information in the portlet as it moves vertically. Here, also, you
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can enter a URL so that another Web page displays when the user clicks on specific
data in the portlet. You can also specify whether the secondary Web page displays in a

new window.

Figure 3—-18 Layout Tab: News

News Style

& Plain
© Logo

© gerolling

Column Layout
Selectthe columns to display in the news Heading.

Data View

Sample Data.
Kathleen Bayyat <Headlne>

Customize Help About T *

Presidant - Manufacturing <Callout>
Robert Rodriguz

President - Sales
Edward Shiglds

Chief Financial Officer
Jan Francois Stewart

Graphic Artist

Name Column Display As  Action URL
Field1 |employee_Id j |Texl j |<Nune= j I
Selectthe columns ta display in the news Callout.
Name Column Display As  Action URL
Field2 [MName =l [ted =] [sMone= =] |
Field? |Gender =l [ted =] [sMone= =] |
Fields [Jab =l [ted =] [sMone= =] |
Fields [Email =l [ted =] [sMone= =] |

Figure 3-19 shows an example OmniPortlet using a news layout.

Note: The News Layout Scroll type in OmniPortlet is supported
on Microsoft Internet Explorer and Netscape 7.0.

Figure 3-19 Example of an OmniPortlet Using a News Layout

OmniPortlet

20

Hathleen Bayyat

F

President - Manufacturing

khayyatid@oracle.com
30

Fobert Rodriguz

M

President - Sales

rrodriguigdoracle com
40

Edward Shields

M

Chief Financial Officer

eshieldsi@oracle.com

Note: For more information on using the OmniPortlet Wizard,
click the Help link in the upper right corner of the Layout tab.
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3.2.5.4 Bullet Layout

You can use the bullet layout to display your data in a bulleted list. The Layout tab
(Figure 3-20) provides a variety of different bullet and numbered bullet styles. In the
Column Layout section, you can choose how the columns will display in the portlet, as
well as whether a second Web page will display when the user clicks that column. You
can also specify whether the second Web page displays in a new window.

Figure 3-20 Layout Tab: Bullet

Bullet Style
@ Disc Data View Customize Help About T =
© Circle  [Sample Data.
("Square = Kathleen Bayyat President - Manufacturing
Robert Rodriguz President - Sales
©1,2,3 Edward Shields Chief Financial Officer
o Jan Francois Stewart Graphic Artist
ahec Lisa Wiliams Graphic Artist
Cap o Sandra Kyte Course Developer
- o Eaule Yau Customer Sales Representative
i, i, iii
L&A RTNII]
= Mane
Column Layout
Select the columns to display in the bullet list
MName Column Display As  Action URL
Fieidt [employee_id 7| [Ten 7] [<none= =] |
Field2 [Name =l fren =] [ewone= =] |
Field3 |Gender =l fren =] [ewone= =] |
Field4 [Jab =l fren =] [ewone= =] |
Fields |Email =l fren =] [ewone= =] |

Figure 3-21 shows an example of an OmniPortlet using a bullet layout.

Figure 3-21 Example of an OmniPortlet Using a Bullet Layout

OmniPortlet

# 20 Kathleen Bayyat F President - Manufacturing kbayyat@oracle com
30 Robert Rodriguz M Presidert - Sales rrodriguig@oracle.com

40 Eclward Shislds M Chief Financial Officer eshislda@oracle.com
110 Jan Francoiz Stevwwart M Graphic Artist jfrancoid@oracle.com

100 Liza Willians F Graphic Adist wiliami@oracle.com

430 Sandra Kyte F Course Developer skytei@aracle .com

770 Eaulo Yau F Customer Sales Representative eyaui@aracle.com

Note: For more information on using the OmniPortlet Wizard,
click the Help link in the upper right corner of the Layout tab.

3.2.5.5 Form Layout

You can use the form layout (Figure 3-22) if you have data you want to display as
labels or default values in a form, such as Name: <name>. You can then use portlet
parameters and events to pass data to the selected row.
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Figure 3-22 Layout Tab: Form

Form Style

© vertical Data View
€ Horizontal |Sample Data.

Name: [Kathleen Bayyat
Job: [President - Manufacturi

Customize Help About T =

salary: [T0D000
Commission: [100000
Column Layout
Selectwhich columns to display in the farm.
Name Column Label Column Alignment  Display As  Action URL
Field1 Iempluyeeild |emmuyeejn =1 |Leﬂ | |Tex1 | |=Nnne> =l I
Field2  [Mame [Hame =] Jren =] [Ted =] [<Mone= =] |
Field3  [Gender [Gender =] Jren =] [Ted =] [<Mone= =] |
Fieida  [Job [Job =] Jren =] [Ted =] [<Mone= =] |
Fields  [Email [Email = [tet =] [Ted =] [<mons= =] |

You can also specify whether to display the target of a URL in a new window
(Figure 3-23). Figure 3-24 shows an example of an OmniPortlet using a Form layout.

Figure 3-23 Open In New Window Check Box

Action URL m:ﬁ:;;:‘.ﬂew
|=:N|:|ne:= = | r
|=:N|:|ne:= = | r
|~::N|:|ne:=- - | r
|~::N|:|ne:=- - | r
|~::N|:|ne:=- - | r

Figure 3-24 Example of an OmniPortlet Using a Form Layout

OmniPortlet

Employee ID 20
Marme Kathleen Bayyat
Gender F
Job President - Manufacturing
Email kbayyati@oracle.com

Employee [T 30
Mame Robett Rodriguz
Gender M
Jok President - Sales
Email rrodrigui@oracle.com

Note: For more information on using the OmniPortlet Wizard,
click the Help link in the upper right corner of the Layout tab.
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3.2.5.6 HTML Layout

You can use the HTML layout to create a customized look and feel for your portlet by
choosing from either a built-in HTML layout and modifying the code, or by creating a
new layout from scratch. You can hand-code your own HTML or JavaScript based on
data columns that OmniPortlet has retrieved based on the selected data source
(Figure 3-25). By coding your own HTML and JavaScript, you have full control over
the appearance and can develop a rich interface for your portlet. For an example of

using JavaScript in the HTML layout, choose the Sortable Table layout from the Quick
Start list on this tab.

Figure 3-25 Layout Tab: HTML

Quick Start
Use the Quick Start to populate the sections below with starting HTMWL code.

Quick Start | Clear Fields — ~ Apply

& Tip Clicking the Apply button permanently deletes any content currently in the below sections and replaces it with the template code

¥ Non-Repeating Heading Section

Ingert data label or system variables into text area: | currency | Inser

<tabTe border="0" cellpadding="0" cellspacing="0" width="100%">
<thody><tr>
<td  width="94%">

<span class="green">Currency Exchange</spans

<script type="text/javascript"s

Amwumber of currencies supported.

var currwo = 8;

Slarrays storing the currencies and image 1inks.
war curr = new Array(currio);

war flag = new array(currio);

fisarrinn tha Flame accarcding ta tha calacrinm dn tha dran_down 15or i

& Tip HTML code entered in the above section displays after the contents of the Header text box an the Wiew tab.

¥ Repeating Section

Insert data colurmn or systerm variable into text area: | currency > Insert
A/storing the data returned by the data source into 1S arrays.

curr [##0P_ROWNUMIE] = “##currencydd’;

F1ag [##0P_RoOwNUM#ER] = "##flages”;

& Tip HTML code entered in the above section displays once far each data record.

¥ Non-Repeating Footer Section
Insert data label or syster variable into text area: | currency | Insert |
Figure 3-26 shows an example of an OmniPortlet using the HTML layout.

Figure 3-26 Example of an OmniPortlet Using the HTML Layout

Currency Exchange

—=| I
[ ETE e

1 USD = 0.833719 EUR

3.2.6 Edit Defaults mode

After you have created your OmniPortlet and returned to your portal page, you can
click the Edit Defaults icon to change the portlet options if required. You will notice
that, in the Edit Defaults mode, there are tabs that correspond to the different steps in
the OmniPortlet Wizard (except for the Type step) to directly access the different

options. There is also one extra tab, the Events tab, which is explained in the next
section.

When you edit an OmniPortlet using the Edit Defaults mode, keep in mind the
following notes:
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3.2.7 Events

A new mode, "none," is the default setting for the Locale Personalization Level of
OmniPortlet and the Simple Parameter form. This mode indicates that, when you
edit the portlet defaults using the Edit Defaults mode, the changes apply to all
users, regardless of the current Oracle Portal session language and the locale of
your browser. For more information about these settings, see Oracle Fusion
Middleware Administrator’s Guide for Oracle Portal.

You can personalize the portlet at runtime by clicking the Personalize link on the
portlet. When you personalize the portlet, a complete copy of the personalization
object is created. Since all properties are duplicated, subsequently modifying the
portlet through Edit Defaults will not be reflected in the personalized version of
the portlet. To ensure the latest changes are made to the portlet, you must click
Personalize again (after the modifications from the Edit Defaults wizard are
made), then select the Reset to Defaults option.

By default, the OmniPortlet provider uses the file-based Preference Store to store
the personalization object, which stores the object in a file system in the
middle-tier. If you decide to deploy OmniPortlet in a multiple middle-tier
environment, you must use a shared Preference Store, such as the database
Preference Store (DBPreferenceStore). To do so, you can choose to do one of the
following:

s Use a file-based Preference Store now, then migrate to the database Preference
Store later using the PDK Preference Store Migration Ultility.

= Configure OmniPortlet to use the DBPreferenceStore, and follow the steps on
configuring Portal Tools and Web providers in Oracle Fusion Middleware
Administrator’s Guide for Oracle Portal.

On the Events tab (Figure 3-27) in the Edit Defaults mode of the OmniPortlet Wizard,
you can identify event parameters based on the portlet parameters you selected on the
Source tab.

Figure 3-27 Events Tab of the OmniPortlet Wizard

Edit Defaults: OmniPortlet

Event Outputs

Ewent output can be passed to a target page as page parameters.

When Event1 is raised, pass:

Event1Pararn1 = | <Null> j
Event1Param2 = |=Null> I
Event1Param3 = |<Null> I

When Event2 is raised, pass:

EventZParam1 = |=<Null> I
EventZ2Param2 = |<Null> I
EventZParam3 = |<Null> I

When Event3 is raised, pass:

EventiParam1 = |<Null> I
Event3Param2 = |<Null= il
Event3Param3 = |=Null> |
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3.3 Parameters and Events

Out of the box, OmniPortlet can receive up to five parameters and raise up to three
events. Each of the events can send one or more parameters. For example, you can set
up a chart that displays the employees in a department. When the user clicks one piece
of the chart (for example, a department name), an event is raised that sends a
parameter to the page. The page may then pass a parameter to all the portlets on that
page that display information about the employees. Then, all the portlets on the page
display information about the employees in the selected department.

Note: To learn how to use parameters and events with
OmniPortlet, follow the steps in Chapter 4, "Building Example
Portlets with OmniPortlet". If you are comfortable with the
provider.xml file, you can add more parameters and events by
editing the file.

To set up parameters and events, you must first enable the page group to accept
parameters and events. In Oracle Portal, parameters and events are enabled by default.
Then, you set up each portlet to accept the necessary parameters, and raise the
required events. After you've set up the portlet parameters, you can link the portlets
together by setting up the page-level parameters and events.

3.3.1 Portlet Parameters and Events

Out of the box, you can define up to five portlet parameters for an OmniPortlet. You
can define parameters in the following places:

= On the Source tab of the wizard when you define the OmniPortlet
= On the Source tab when you select Edit Defaults for the OmniPortlet

Figure 3-28 shows the Portlet Parameters section on the Source tab.

Figure 3-28 Source Tab: Portlet Parameters Section

Parameter Name Default Value Customizable Customize Page Label Customize Page Description
Pararn1 I [ IF‘aram1 IDescription for Parameter 1
Pararn?2 I [ IF‘aram2 IDescription for Parameter 2
Pararn3 I [ IF‘aram3 IDescription for Parameter 3
Pararnd I [ IF‘aramfi IDescription for Parameter 4
Pararns I [ IF‘aram5 IDescription for Parameter 5

Parameter values determine what data is displayed in the portlet. You can also use a
parameter to pass a value in a URL or to embed a value in the portlet text.

Note: You can learn more about portlet parameters in the online
Help, which you can access by clicking the Help link on the Source
tab in the OmniPortlet Wizard. The online Help describes portlet
parameters in detail, and how to set them up for your OmniPortlet.
You can also refer to Oracle Fusion Middleware User's Guide for Oracle
Portal.

You can set up each OmniPortlet to raise up to three events. Each event can pass up to
three parameters. Each parameter can be a portlet parameter, such as Param]l, or a

Creating Portlets with OmniPortlet 3-21



Parameters and Events

data source column, such as Department_No. You set up events on the Events tab in
the Edit Defaults mode of OmniPortlet (Figure 3-29).

Figure 3-29 Events Tab

Event Outputs
Event output can be passed to atarget page as page parameters.

hen Eventl is raised, pass:

EventiParam1 = [Deptho i
EventiParam? = [Department Ihd
EventiParam3 = [=MNull= Ihd

When Event? is raised, pass:

Event2Param1 = [=MNull= Ihd
Event2Param2 = |=<Null= Ihd
EventzParam3 = |<MNull= 'l

When Event3 is raised, pass:

EventiParam1 = |=<Null= i
EventiParam2 = |=Null= Ihd
Event3Param3 = |=Mull= Ihd

3.3.2 Page Parameters and Events

After you've set up the parameters and events for each OmniPortlet on a portal page,
you can map the portlet parameters and events to other portlets on the same page. For
more information on using page parameters and events, refer to the Oracle Portal
online Help and Oracle Fusion Middleware User’s Guide for Oracle Portal.
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Building Example Portlets with OmniPortlet

This chapter shows you how to use OmniPortlet to create four portlets based on
different data sources: a Web service, a spreadsheet (CSV), XML, and an existing Web
page. You will build these portlets based on the various built-in layouts, and will
create a separate portlet based on an HTML layout. You will learn how to create and
modify these portlets, as well as use page parameters and events to add interactivity to
your portal page.

This chapter includes the following sections:

Section 4.1, "Adding an OmniPortlet Instance to a Portal Page"

Section 4.2, "Building an OmniPortlet Based on a Web Service"

Section 4.3, "Building an OmniPortlet Based on a Spreadsheet (CSV)"
Section 4.4, "Building an OmniPortlet Based on an XML Data Source"
Section 4.5, "Building an OmniPortlet Based on a Web Page Data Source"
Section 4.6, "Setting Up Portlet Parameters and Events"

Section 4.7, "Building an OmniPortlet Using the HTML Layout"

Note: To learn more about specific pages and tabs in OmniPortlet,
click the Help link in the top right corner of the wizard. The online
Help describes the contents of the selected page or tab. You can also
find more information about using OmniPortlet in Chapter 3,
"Creating Portlets with OmniPortlet." or about registering and
configuring OmniPortlet with Oracle Portal in Oracle Fusion
Middleware Administrator’s Guide for Oracle Portal.

At the end of this chapter, you will create a page that contains four portlets, as shown
in Figure 4-1.
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Figure 4-1 Portal Page with Four OmniPortlet Examples

Oracle Application Server i ——
Portal OmniPortlet Examples e Hee

Edt Personelize  Accourtinfo  Lowout

+

Weather Forecast Travel News
Forecast per Zip Code & Temple Town Near Kyoto, et Serenely Distant
Day High Low  Precipitation A Templs Town Near Kyato, Yet Serenely Distant
[y— 55 45 a Nara, with s serens temples and enchanted forest, Is an antidote to ts noisy neighbor
Source: The New York Times
TREEEE & @ @ Weather Information
Wednssday &1 a0 0 55 Farecast for San Mateo Courty
Mostly sunny. Highs from the lower B0z coastside to the 80s inland. Afternoan seabreeze
Thursday 80 70 0 g 2] 10te 20 mph.
pl Today
Fricay 63 50 0 - Mostly sunny. Areas of morning low clouds and fog... clearing to the coast by midday. Highs
o from the upper S0z and lower 60s coastside 1o the 80s inland. Afternoon sesbreeze 1010
Saturday 7 55 0 b 20 mph.
c Tuesday
Sunday B8 50 o Source: Weather Underground

Major U.S. Urban Areas - Population P

W Hew Yok [JlosAngeles [ Chicaga
[Jiashington  [I San Francisco [ Detroit
[ rallas

Drag your mouse over a pie section to view the population of the
specified urban area.

All four of these example portlets require you to be able to connect to the Internet. If
M o you must use a proxy server to connect to the Internet, you will need to configure the

HTTP proxy settings on the OmniPortlet Provider Test page to use proxy
authentication. If the OmniPortlet provider has been set up to use proxy
authentication that requires your login, you can enter your user information in the
Proxy Authentication section of the Source tab in the OmniPortlet wizard. For more
information on proxy authentication, refer to Section 3.2.2, "Source." For specific
information on configuring the provider's proxy settings, refer to the Oracle Fusion
Middleware Administrator’s Guide for Oracle Portal.

Note: The steps in this chapter assume that you are using the
OmniPortlet provider that is available with Oracle Portal. If you
installed the Oracle Portal Developer Kit separately, you may need
to slightly modify the instructions when adding an OmniPortlet
instance to the page. Instructions for registering and configuring
OmniPortlet with Oracle Portal are located in Oracle Fusion
Middleware Administrator’s Guide for Oracle Portal.

4.1 Adding an OmniPortlet Instance to a Portal Page
In this section, you will learn how to add an OmniPortlet instance to your portal page.
To add an OmniPortlet instance to a page, perform the following steps:

1. In the Edit mode of the page where you want to add the OmniPortlet, click the
Add Portlets icon.

2. On the Add Portlets page, in the Available Portlets list, click the Portlet Builders
link.

3. C(lick the OmniPortlet link.
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4. Click OK. The new instance of OmniPortlet now displays on your portal page, as

shown in Figure 4-2.

Figure 4-2 OmniPortlet Instance on a Portal Page

& FE » FAREE %

OmniPortlet

This portiet is not defined yet. Click the "Edit Defauti” icon or the "Customize” option in the drop down list to define it

Note: On the IBM Linux on Power platform, if the action buttons
(Next, Previous, Finish, and Cancel) are minimized to dots when
defining the OmniPortlet, increase the stack size shell limit to
unlimited and restart the WLS_PORTAL instance. Run the following
command to set the stack size shell limit to unlimited:

prompt> ulimit -s unlimited

4.2 Building an OmniPortlet Based on a Web Service

The steps in this section will show you how to create a portlet that displays weather
forecast information for a particular zip code. You will base this portlet on the Web
Service available on the Oracle Technology Network. You will need Internet access to
be able to complete this section.

To create an OmniPortlet based on a Web Service, perform the following steps:

1.

In the new OmniPortlet instance on your portal page, click the Edit Default link to
start the OmniPortlet Wizard.

On the Type page, select the Web Service radio button, then click Next.
On the Source page, in the WSDL URL field, enter the following URL:

http://webservices.oracle.com/WeatherWS/WeatherWS?WSDL

Note: This Web Service has one method
(WeatherWs.giveMeSomeWeatherInfo) and accepts one
parameter (param0). If you use a method that has parameters, the
parameters will display in this section of the tab. You can enter a
sample value for the parameter, then click Test to view the sample
XML data, the SOAP response, and the SOAP Request.

Click Show Methods.

In the Web Service Methods section, in the param0 parameter field, enter a sample
Zip code (for example, 94065), then click Test. The Web Service: Test Result
window displays, where you can verify the XML data returned by the Web
Service, as shown in Figure 4-3.
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Figure 4-3 OmniPortlet: Web Service Test Results Page

Web Service: Test Result
XML Data
This is the resulting XML data, extracted from the SOAP response body, which will be

used to render the portlet. If the extracted "sML Data” is not of <ROWSET=/<ROW=
format, you need to apply an XSL filter to convert it to this format.

wsiitype="nsZ:Array" xmins:xsi="http:Awvww w3, orgf2001MLSchema-instance”
xmins:ns3="http://pdo/Weatherv'S xsd" ns2:array Type="ns3:pdg_WeatherBean
[71"=
<item xsiitype="ns3:pdy_WeatherBean">
<dayOfyeek xsitype="xsd string">
honday
<fdayOfWeek=
<hiTemp xsitype="xsdint">
55
</hiTemp=
<img xsi:type="xsd: string">
AeatherWS/Rainy. gif
<fimg=
<lowTemp xsitype="xsd:int"=
45
=flowTemp>
<precip xsitype="xsd int"=
a

=precip> =l

<return xmins:ng2="http://schemas. xmlsoap.org/soap/encoding” j

6. Close the window.

The Source page should look like the image shown in Figure 4-4.

Figure 4-4 OmniPortlet: Web Service Source Tab

w
/

| - o

WEDL URL  |http:/Aweb: oracle.com/Meather ather DL Shaw Methods
Weh Service Methods

Available methods for this Web Serice | WeatherWS. givehe SomeWWeatherlnfo j Show Parameters

Enter values for the method parameters

paramd |94055 Test

@ TIP You can use the format ##Paramh## (ex. ##Param1## to pass data from the page into the method parameters. Learn more
Optionally enter an XSL fifter to transform the method output
This is useful when the data is not in <ROWSET>/<ROW: format

5L Filter URL [ (Test)
Optionally enter an XML Schema to describe the method output
This is useful when the XML data doesnt have data for all fields or to override what is defined in the XML data

XML Schema URL |

@ TIP You can use the farmat ##R arambi (ex: ##Param1##) to pass data fram the page inta the URLs. Learn more

Note: If you do not have access to the Internet, you can use a
different Web Service, but keep in mind that your results will not
match the example in this chapter.

7. Click Next.

8. On the Filter page, click Next.

9. On the View page, in the Title field, enter Weather Forecast.
10. In the Header Text field, enter Forecast per Zip Code.

11. Make sure the Show Header Text check box is selected, and clear the Show Footer
Text check box, as shown in Figure 4-5.
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Figure 4-5 OmniPortlet: Web Service View Tab

Title |Weather Forecast
Header Text |TOFecast per Zip Code
Show Header Text
Footer Text

[ show Footer Text

12. Make sure the Tabular radio button is selected, then click Next.

13. On the Layout page, select the Plain radio button.

14. Specify the Column Label, Column, and Display As properties for your data

according to Table 4-1.

Table 4-1 Column Properties for the Weather Forecast Portlet

Column Label Column Display As
Day dayOfWeek Text

High hiTemp Text

Low lowTemp Text
Precipitation precip Text
(Blank) img Image

15. Now that you've completed defining the portlet, click Finish. Your portlet should

look like Figure 4-6.

Figure 4-6 OmniPortlet: Web Service Portlet

Weather Forecast

Forecast per Zip Code
Day High
Manday a5
Tuesday )
Wiednesday &1
Thursday =i}
Friclay 63
Saturday 7o
Suncay G2

Low

45

i)

a0

a

a0

25

a0

Precipitation

0 Lz
: ¢
: 25
: 25
0 P
0 oz
0 4:” :

4.3 Building an OmniPortlet Based on a Spreadsheet (CSV)

The steps in this section show you how to use OmniPortlet to define a portlet that
displays regional information based on a spreadsheet (CSV) data source. This portlet
will display the population of major U.S. urban areas in a pie chart.
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To create an OmniPortlet based on a spreadsheet, perform the following steps:

1.

2
3
4.
5

10.
11.

12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

Create a region below the existing region on your portal page.

Add an OmniPortlet to this new region.

Start the OmniPortlet Wizard by clicking the Edit Default link.

On the Type page, select the Spreadsheet radio button, then click Next.

On the Source page, in the CSV URL field, replace the existing text with the
following CSV:

http://webservices.oracle.com/WeatherWS/city_ population.csv

Note: If you do not have access to the Internet, you can use the
default URL, but keep in mind that your results will not match the
example in this chapter.

Ensure that the Use first row of spreadsheet for column names check box is
selected

Click Next.
On the Filter page, click Next.

On the View page, in the Title field, enter Major U.S. Urban Areas -
Population.

Clear the Show Header Text check box.

In the Footer Text field, enter Click a pie section to view the
population of the specified urban area.

Note: The text you just entered in the Footer Text field instructs
your end users to click a pie section to view more details about the
selected population. To enable this feature, you will need to
complete the steps in Section 4.6, "Setting Up Portlet Parameters
and Events".

Ensure that the Show Footer Text check box is selected.

Under Layout Style, select the Chart radio button, then click Next.
On the Layout page, select the Pie radio button.

In the Width field, enter 300.

In the Height field, enter 300.

From the Legend list, choose Top.

Select the 3D Effect check box.

Under Column Layout, from the Group list, choose <None>.
From the Category list, choose City.

From the Value list, choose Population. The Layout tab should now look like the
image shown in Figure 4-7.

4-6 Oracle Fusion Middleware Developer's Guide for Oracle Portal



Building an OmniPortlet Based on an XML Data Source

Figure 4-7 OmniPortlet: Character-Separated Values (CSV) Layout Tab

" Bar Data View Customize Help About F *
* pie |Sample Data.
<ateqony
 Line “Valug= a Pres
21.695% 8 Chief
o igraphic
12.0F% G0.24%
o0 Course
10 o5ales
<Groups

YWidth ISDEI pixels
Height ISDEI pixels
Legend ITl:up 'I

¥ 3D Effect

Column

Group | =Mone= vI
Category | City TI
Yalue | Population TI

22. Click Finish.

Your portlet now displays on your portal page below the Weather Forecast portlet,
and should look like Figure 4-8.

Figure 4-8 OmniPortlet: CSV OmniPortlet on the Page

Major U.S. Urban Areas - Population

[WHew Yorkk  [JLos Angeles [l Chicago
[CIwashington [ 5an Francisco [l Detroit
[ODallas

Click a pie section to view the population of the specified urban area

4.4 Building an OmniPortlet Based on an XML Data Source

The steps in this section will show you how to use OmniPortlet to define a portlet that
displays news information in a scrolling layout, based on an XML data source.
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To create an OmniPortlet based on an XML data source, perform the following steps:

1. Create a region next to the Web Services portlet (Weather Forecast) on your portal
page.

Add an OmniPortlet to this new region.

Start the OmniPortlet Wizard by clicking the Edit Default link.

On the Type page, select the XML radio button, then click Next.

On the Source page, in the XML URL field, enter the following URL:

o ©Dbd

http://www.nytimes.com/services/xml/rss/nyt/Travel.xml

Note: If you do not have access to the Internet, you can use a
different RSS feed, but keep in mind that your results will not
match the images in this example.

6. In the XSL Filter URL field, enter the following URL for the XSL file:

http://www.oracle.com/technology/products/ias/portal/viewlets
/omniportletnews.xsl

Note: This XSL filter transforms the RSS news feed into the
ROWSET /ROW structure that OmniPortlet can consume.

7. Click Next.

8. On the Filter page, click Next.

9. On the View page, in the Title field, enter Travel News.

10. Clear the Show Header Text check box.

11. In the Footer Text field, enter Source: The New York Times.

12. Ensure that the Show Footer Text check box is selected.

13. Under Layout Style, select the News radio button, then click Next.

14. On the Layout page, under News Style, select the Scrolling radio button.
15. In the Width field, enter 475.

16. In the Height field, enter 50.

The News Style section of the Layout tab should now look like the image shown in
Figure 4-9.

Figure 4-9 OmniPortlet: XML Layout Tab - News Style

= Plain Data View Customize Help About T =
' Logo Sample Data.
@ Scralling

an Francois Stewart
Graphic Artist

YWidth |4F5 pixels
Height IEEI pixels

4-8 Oracle Fusion Middleware Developer's Guide for Oracle Portal



Building an OmniPortlet Based on a Web Page Data Source

17. Under Column Layout, next to Field 1 choose title from the Column list,
Hyperlink from the Action list, and enter ##1ink## in the URL field, as shown in
Figure 4-10.

Figure 4-10 OmniPortlet: News Style Column Layout

Name Column Display As Action URL

Fieldl |[title x| [Text =] |Hyperlink =] [|estinki

18. Next to Field2, choose description from the Column list and leave the default
values for the other settings. Ensure this section of the Layout tab looks like
Figure 4-11.

Figure 4-11 Column Layout Section of the Layout Tab

Name Column Display As Action URL
Fieldl |title x| fText =] [Hyperink =] [winkse
Name Column Display As Action URL
Field2 |description »| |Text | |=Mone> =

Fieldd | <Mone> =] |Text =| |=None> ¥

Fieldd | <Mone> =] |Hidden =| |=None> ¥

Fieldd | <Mone>  >| |Hidden =| |<None> >

19. Click Finish.

Your portlet now displays on your portal page, as shown in Figure 4-12.

Figure 4-12 OmniPortlet: XML Scrolling News OmniPortlet on the Page

Travel News Customize T

Up=scale Flavors on Chicago's Morth Side

Restaurants with laid-back style arrive on the Morth Side of Chicago.

ource: The Hew York Times

4.5 Building an OmniPortlet Based on a Web Page Data Source

The steps in this section will show you how to use OmniPortlet to create a portlet that
displays weather information in a text format based on an existing Web Page. In this
section, you will use OmniPortlet to clip and scrape content from Web sites.

To create an OmniPortlet based on a Web page data source, perform the following
steps:

1. Create a region below the XML portlet (Travel News) on your portal page.
2. Add an OmniPortlet to this new region.

3. Start the OmniPortlet Wizard by clicking the Edit Default link.

4

On the Type tab of the OmniPortlet Wizard, select the Web Page radio button,
then click Next.

5. On the Source tab, click Select Web Page.
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6. On the Web Clipping Studio page that displays, in the URL Location field
(Figure 4-13), enter the URL of the page you want to clip:

http://www.wunderground.com

Note: You can use a different Web page, but keep in mind that
your results will not match the example in this chapter.

Figure 4-13 URL Location Field

URL Location |http:ffwww.wundergr0und.com [ Start )

Note: In this example, we use a third party Web site owned by
The Weather Underground, Inc. Because this Web site is
continually updated based on current weather forecasts, the images
and steps included in this section may not reflect exactly what you
see when you create this example. As you go further into this
example, some of the steps may not work, as the owners may
change the technology of this third party Web site.

7. Click Start to display the Web Clipping Studio. You should see the Web page
display in the Web Clipping Studio, as shown in Figure 4-14.

Figure 4-14 Web Clipping Studio Containing the www.wunderground.com Home Page

ORACLE ?
| = : Y Y
Web Clipping Studio Cocel Secton b

Find the Weather for any City, State or
ZIP Code, or Airport Code or Countb

™

wunderground.com
POyMabile

Winder | MEXRAD | Hegional | WEWZoom | Trin

FemmmeE Photos Radar Radar Satellite Maps Planner
Tropical / " g g A Personal Weather
Hurticans Marine | Severe | Astronory | Ski | Education | Favorites Stations

Member Benefits: | i
No Ads Find the Weather for any City, State or

™

Weather Email ZIP Code, or Airport Code or Countli

§5 a year I
Signup Here wunderground.com

A kil K

4]

Email

Password [ Map Type: JUS Temperaure

Temperature Click on map for current conditions and forecasts. Unlte(l Sta'

Login | Heat Index
Windchill
Humidity
Page Prefs Radar

8. On the home page, enter a zip code (for example, 94065) in the Weather field, as
shown in Figure 4-15, then click the magnifying glass icon next to the field.
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Figure 4-15 Entering the Zip Code 94065 into the Weather Field

ORACLE

Web Clipping Studio

Find the YWeather for any City, State or
ZIP Code, or Airport Code ar Countb

H4065

wunderground.com

9. The weather information for Redwood City, California displays in the Web
Clipping Studio. A segment of the page is shown in Figure 4-16.

Figure 4-16 Weather Information for Redwood City, California

Redwood City, California
Local Tirne: 3:01 PM PDT Set My Timezone

Tropical Weather: East Pacific: Tropical Storm Adrian

I T

Updated: 2:48 PM PDT on May 18, 2005 Wed Thu

Observed at San Carlos, California (History)

Elevation: 3 ft/ 1 m By w Il\
=166 °F / 67" | 55° 0 | 56°

o =}
- 19 C Rain Chance of Rain
Mastly Cloudy Detail Detail

Hurnidity:  78%

Dew Point: 59 °F /15 °C

Wind: 12 mph / 18 kim/h
from the South

Click Detail for hourly wind, temperature, humidity an
Alternate Computer Forecast: AN MOS Weather Gr
1

10. In the top right corner of the Web Clipping Studio, click the Section button, as
shown in Figure 4-17.

Figure 4-17 The Section Button

Y 98 Y

Cancel Back Section Helg

11. After you click the Section button, you'll notice that the elements of the Web page
are broken down, and that a new icon displays called Choose at the top of each
section. Figure 4-18 shows a snapshot of the Web Clipping Studio.
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Figure 4-18 Web Clipping Studio Displaying the Web Page Sections

Web Clipping Studio
L
Bonosss
r——
B Find the Weather for any City, State or ZIP Code, or Airport Code or Country
™
- [3)
wiunderground.com G"D‘“?
FDAMobile
LEr——
Bonosas
/ Features: Wonder Photos | MEXRAD Radar | Regional Radar | Zoom Satellite | Maps I Trip Planner
Tropical / Huricane | Marine | Severe | Astronomy = Ski | Education = WEW Blogs | Favorites | Personal Weather Stations
M ooose
MEMBER BENEFITS
Per P
Year! l
NO ADS & WEATHER EMAIL
e EEn EEEEEEEEEEEEEEEEEEEESR
Email L
005
Password a n A
Redwood City, California
Login Bonosas
Local Time: 3:04 PM PDT Set My Timezone
™ 005 Borocse
. Print This Page Tropical Weather: East Pacific: Tropical Storn Adrian
Current Conditions M cracse
Forecast Fiyer Updated: 2:48 PM PDT on May 18, 2005 =)
Page Prefs Observed at San Carlos, California (History’ 5 Day F
Language: Elevation: 3 ft/ 1 m Ay -ore
i Thu
English | o o
Units: Both 66 F/19°C L
Istric | English Mostly Cloudy ; )
Timazana Humidity 78% e

12. Find the section shown in Figure 4-19, which shows the weather information for

the city you chose (in this example, San Francisco Bay Shoreline).

Figure 4-19 Weather Information for San Francisco Bay Shoreline with the Choose Icon

Forecast for San Francisco Bay Shoreline

G'roose
Updated: 9:45 PM PDT on September 18, 2007
C"roose

m M Active Advisories (US Severe Weather)

G'roose
Shocse Tonight
* G'roose

Mostly clear. Lows in the upper 505, West winds 5to 20 mph.

G'roose
C"roo.se
Ghoose ywadnesday
d'l,\;_".i‘ C"roo.se
L | Mostly sunny in the marhing then becoming parly cloudy. Highs in the upper

B0z Westwinds 15 to 25 mph.
G'roose
# ZIP Code Detail

13. Click the Choose icon for this section, located directly above the "Forecast for San
Francisco Bay Shoreline" title bar, as shown in Figure 4-19. The section displays in

the Web Clipping Studio, as shown in Figure 4-20.
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Figure 4-20 Weather Information Section for San Mateo County in the Web Clipping
Studio

Web Clipping Studio

Forecast for San Mateo County
Updated: 3:30 am PDT on May 18, 2005

m Mo Active Advisories (US Severe Weather)

- Today
@ Occasional light rain. Highs in the 605, South winds 10 to 25 mph with local gusts to 35 mph at the coast.
Detail

£ Tonight
Wostly cloudy with a chance of rain this evening. Rain chances decreasing overnight. Lows in the 80s. Southwest winds 5 to 10 mph.

== ] Thursday
“_ | Partly to mastly cloudy with a chance of rain. Highs in the 50z to mid 705, West winds & to 15 mph.
L | Detail

Thursday Night
Partly cloudy. Lows in the 50s. West winds 5 to 15 mph.

14. After you have chosen the clipping, you can refine your data further by scraping
the data, that is, selecting specific cells you wish to display in your portlet. Click
the Scrape button (Figure 4-21).

Figure 4-21 The Scrape Button

® X)) g 2

J - i =
cancel Unselect Scrape Helg

15. While in Scraping mode, you can identify the text pieces in the Web clipping by
selecting the check boxes next to each item. You can repeat these items at the
column level, row level, or table level.

In this example, we want to show the title and the description of each resulting
article from our search. We can repeat the title and description at the row level, so
that each result returned by the search displays only the title and the description
of every result. In general, you choose the text items in the first row that contains
all the pieces you wish to repeat for each row.

After you click the Scrape button, you'll notice that check boxes display next to
each item on the Web page, as shown in Figure 4-22.

Figure 4-22 Scraping Check Boxes
Updated: O02:30 PM PST on February 11, 20050 im

a Mo Active Advisories DS Severe eathe:hC L]

16. Select the output you want by selecting the check boxes next to the
items.Figure 4-23 shows an example of a check box.
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Figure 4-23 Check Box for San Mateo County Title

Forecast for San Mateo Countyl®

Note: Depending on the color of the section you want to select,
the check boxes may not be prominently displayed.

17. After you select the check box for "Forecast for San Mateo County," notice that a
corresponding label displays in the Data section of the Web Clipping Studio at the
bottom of the screen, as shown in Figure 4-24.

Figure 4-24 San Mateo County Label in Data Section

NAME VALUE

DefaultMNameForForecastforSantate  Forecast for San Mateo County

18. In the Name field, enter a more meaningful name, such as
"SanMateoCountyForecast." Do not include spaces in the name.

19. Select the fields you wish to display and add the corresponding labels as you
select them. The following is a list of sample information we chose for this
example, but you can choose your own examples depending on the current
weather. You can see the following selected weather information in Figure 4-25:

»  Forecast for San Mateo County title
= Today

= Today's Weather

s Thursday

»  Thursday's Weather
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Figure 4-25 Selected Weather Information

Forecast for San Mateo County
Updated: 03:30 am PDT on May 18, 200500)

Eg Na Active Advisories Cus Severe weatreH0 T

F,‘ TodayE
é:) Occasional light rain. Highs in the B0s. South winds 10 to 25 mph with local gusts to 35 mph at the coast
-
T Detaild

] Tonightd
L Mostly cloudy with a chance of rain this evening. Rain chances decreasing overnight. Lows in the 50s. Southwest winds 5 to 10 mph. O
[m]

B

ThursdayE
Partly to mostly cloudy with a chance of rain. Highs in the B0s to mid 70s. West winds 5 to 15 mph
T Detaild

Thursday NightQ
Partly cloudy. Lows in the S0s. West winds & to 15 mph. O
[m]

[y

B

FridayO
Partly cloudy. Highs in the B0s to upper 70s. Morthwest winds & to 15 mph increasing to 15 to 25 mph in the aftemoon. O
Detaildl

Friday NightQ
Mostly clear. Lows in the 40s to upper 0. O
: =]

[

Data
Use to identify a cell of data. Then use the "More" and "Less” buttons to expand your selection to include more or less data within the clipping. When
Clipping toolbar.

NAME YALUE
SanMateoCountyForecast Farecast for San Mateo County
Thursday\Weather Partly to masthy cloudy wi...
TodayWeather Occasional light rain. Hig

Today Today

Thursday Thursday

. More | , Less |

Note: With the Web page data source, you can select URLs as part
of your Web clipping. In Oracle Portal 10.1.2 and later, the context
of the application is maintained. So, for example, any images that
display on the hyperlinked page will be maintained.

20. Now that you've selected the data you want to display, click the Continue button,
as shown in Figure 4-26.

Figure 4-26 The Continue Button

¥ '
LS IS I

Cancel Unselect Continue Helg

21. On the page that displays, verify that the information in the Clipping Attributes
section includes the title: "Weather Underground: Redwood City, California
Forecast," as shown in Figure 4-27.

Figure 4-27 Clipping Attributes Section of the Web Clipping Studio

Title |Weather Underground: Redwood City, California (94065) F
Description |New Desc
Time Cut (seconds) |21

22, Verify that the information in the Clipping Parameters section includes the
parameters as shown in Figure 4-28.
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Figure 4-28 Clipping Parameters Section of the Web Clipping Studio

Index URL URL Parameter  Clipping Parameter? Name Value
o Ihtm:fﬂ'WWW wunderground. com none TFA | |
1 Ihnp Hweeewe wunderground. com/cgi-binfindweatt Iqueryj r Iquery IBADEE

23. Select the Clipping Parameter? check box for the second parameter with the name
”query'ﬂ

24. Click OK.

25. On the Source tab of the OmniPortlet Wizard, the new title and description now

display. To edit the Web clipping in the Web Clipping Studio, you can click the
Select Web Page button again, as shown in Figure 4-29.

Figure 4-29 Web Page Source Tab

Title: Weather Underground: Redwood City, California (94065) Faorecast
Description: Mew Desc
Timeout (ms): 25000

| Select'Web Page |

26. Under the Clipping Parameters heading, you should see the clipping parameter
you set on the previous page, as shown in Figure 4-30:

Figure 4-30 Clipping Parameter to Portlet Parameter Mapping

Clipping Parameter  Portlet Parameter  Original Value

guery IF'aram1 'I 94065

27. Under the Portlet Parameters heading, next to Param1, set the Default Value to
the zip code, 94065, as shown in Figure 4-31.

Figure 4-31 Portlet Parameters Section

Portlet Parameters

Parareters are passed to the portlet from the page when the portlet is displayed. These parameters can be mapped to page level parameters by editing the Page Properties

Parameter Name Default Value Personalizable Personalize Page Label Personalize Page Description
Param1 94085 r Param1 Description for Parameter 1
Param2 r Param2 Description for Parameter 2
Param3 r Param3 Description for Parameter 3
Paramd r Paramd Description for Parameter 4
Params r Param5 Description for Parameter 5

28. Click Next.
29. On the Filter tab, click Next.
30. On the View tab, in the Title field, enter Weather Information.

31. In the Footer Text field, enter Source: Weather Underground and make sure
the Show Footer Text check box is selected.

32. Under Layout Style, select the News radio button. The View tab should look like
Figure 4-32.
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Figure 4-32 View Tab with the Options Selected

Header and Footer Text

Title [Weather Information

|
Header Text
|
¥ Show Header Text
Footer Text Source: Weather Underground ;I
|
¥ Show Footer Text
@ TIP Vou can use the format ##Faramhi# (ex: ##Param|##) to pass data fram the page into the text. Leamn mare
Layout Style
Select a layout for the portlet data
 Tabular Data View Cusiomize Help About T *
- Sample Data.
Charl | higen Bayyal <Headline>
& News President - Manufacturing <Gallout
€ Bullst | Rebert Redriguz
President - Sales
CForm | Edward Shickds
€ HTML Ghief Financial Officer
Jan Francois Stewart
Graphic Artist
33. Click Next.
34. Verity that the Layout tab looks like Figure 4-33.
Figure 4-33 Layout Tab
News Style
& Plain Data View Customize Help About T x
- Sample Data.
g Kathlean Bayyat -eadines-
© Scrolling President - Manufacturing <Callout>
Robert Rodriguz
Prasident - Sales
Edward Shields
Chief Financial Officer
Jan Francais Stewart
Graphic Artist
Column Layout
Select the columns to display in the news Heading
. . . Open In New
Name Column Display As  Action URL Window
Field1 SanMateuCuumyFure:astj |Text j |<Nune> j | (|
Select the columns to display in the news Callout.
. " - Open In New
Name Column Display As  Action URL Window
Field2 |TodayWeather | [Text =] [<Mone» ~] 0
Field3 |Today | [Text =] [<Mone» ~] 0
Fieldd |Thursday\Weather | [Text =] [<Mone» ~] 0
FieldS |Thursday | [Text =] [<Mone» ~] 0

35. Click Finish.

36. Your new Web Page portlet displays on the portal page, and should look like
Figure 4-34.

Figure 4-34 Weather Information Portlet on the Portal Page

Weather Information.

Forecast for San Mateo Courty

Occasional light rain. Highs inthe 60s. South winds 10 to 25 mph with local gusts to 35 mph at the coast.
Today

Partly to mostly cloudy with & chance of rain. Highs in the 60s to mid 70z, Yest windz 5to 15 mph.
Thursday
Source: Weather Underground

Now that you have completed building all four example OmniPortlets, your page
should look like Figure 4-35.
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Figure 4-35 Portal Page Displaying the Four Example OmniPortlets

Oracle Application Server ) Home  Hels .
Poreal OmniPortlet Examples
Edt Personalize  Accourtinfo  Lomout
+
Weather Forecast 2 Travel News Personalize 2 T
Forecast per Zip Code & Temple Town Near Kyoto, et Serenely Distant
Day High Low  Precipitation A Templs Town Near Kyato, Yet Serenely Distant
- . .
LD & B o E Nara, with it ssrens teimplss and snchanted forsst, s an antiots o fs nolsy neighbor
Source: The New York Times

TREEEE & @ @ C Weather Information
Wednesday &1 a0 a k2 Forecast for San Matea County

s Wostly sunny. Highs from the lower B0s coastside to the 803 inland. Afternaon seabreeze
Thursday 80 70 0 Q- 10te 20 mph.

ple Today
Friday 63 a0 0 s Wostly sunny. Areas of morning low clouds and fog... clearing to the coast by midday. Highs

"' from the upper 50s and lower B0s coastside to the 80s inland. Afternoon seakreeze 1010

o
Saturday 70 55 0 b o 20 mph.

el Tuesday
Sunday B8 50 o L Source: Weather Underground

Major U.S. Urhan Areas - Population

W Hew Yok [JlosAngeles [ Chicaga
[Jiashington [ San Francisco [ Cetroit
[ rallas

7.801%
7.801%

28 75%

o.518%

10.51%

23 274

12.76%

Drag your mouse over a pie section to view the population of the
specified urban area.

4.6 Setting Up Portlet Parameters and Events

The steps in this section show you how to set up the portlets and page you created to
use parameters. Then, when a user clicks a slice of the pie chart (generating a portlet
event) that corresponds to a region (for example, New York), the Weather Forecast per
Zip Code portlet (based on a Web Service) and the Weather Information portlet (based
on a Web page) will display the corresponding weather information for that region
(New York).

To set up portlet parameters and events, you will need to do the following;:
»  Section 4.6.1, "Configure Portlets to Accept Parameters"

= Section 4.6.2, "Map the Page Parameter to the Portlet Parameters"

= Section 4.6.3, "Configure the Chart Portlet to Use Events"

= Section 4.6.4, "Map the Chart Event to the Page"

4.6.1 Configure Portlets to Accept Parameters

The steps in this section will show you how to configure the two portlets on your page
that accept parameters (the Web Service portlet that displays Weather Forecast per Zip
Code information and the Web page portlet that displays Weather Information).

To configure the two portlets to accept parameters, perform the following steps:

1. In Edit mode of the page, click the Edit Defaults icon in the top left corner of the
Web Services portlet, as shown in Figure 4-36.
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Figure 4-36 Edit Defaults Icon in the Web Services Portlet

B GF E! 7 ®

Weather Forecast
Forecast per Zip Code
Day High

fdonday 55

2. On the Source tab, replace the value of param0 (94065) with ##Paraml##, as
shown in Figure 4-37.

Figure 4-37 paramO Set to ##Param1##

Enter values for the method parameters

paramid I#ﬂjaram’l#ﬁﬁ

3. Under Portlet Parameters, set the default value of Param1 to 94065.
4. In the Personalize Page Label field, enter Zip.

5. Inthe Personalize Page Description field, enter Enter zip code, as shownin
Figure 4-38.

Figure 4-38 Portlet Parameters Section of the Web Services Source Tab

Parameter Name Default Value Personalizable Personalize Page Label Personalize Page Description

Param1 |94065 r IZip IEnter zip code

ParamZ I r IF'aram2 IDescription for Parameter 2

Param3 I r IF'aram3 IDescription for Parameter 3

Paramd I r IF'aramfi IDescription for Parameter 4

Params I r IF'aram5 IDescription for Parameter 5
6. Click OK.

7. On the portal page, in Edit mode, click the Edit Defaults icon for the Web page
portlet, as shown in Figure 4-39.

Figure 4-39 Edit Defaults Icon for the Web Page Portlet

S H

Weather Information

Forecast for San Mateo County
Mastly sunny. Highs from

8. On the Source tab, since you have already mapped a portlet parameter to the

clipping parameter, you can simply add a label and description to the portlet
parameter Param1, as shown in Figure 4—40.
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Figure 4-40 Portlet Parameters Section of the Web Page Source Tab

Parameter Name Default Value Personalizable Personalize Page Label Personalize Page Description

Pararnl IQdDBE - IEip IEnter zip code

Pararmz I - IF'aram2 IDescription far Parameter 2

Pararm3 I - IF'aram3 IDescription for Parameter 3

Pararnd I - IF'aram4 IDescription far Parameter 4

Pararms I - IF'aramE IDescription for Parameter 5
9. Click OK.

You have created two portlet parameters in the Web Services and Web page portlets to
accept page parameters. Next, you will map a page parameter to these two portlet
parameters.

4.6.2 Map the Page Parameter to the Portlet Parameters

The steps in this section will show you how to map the page parameters to the two
portlets you configured in the previous section.

To map the page parameter to the portlet parameters, perform the following steps:

1. On the page, in Edit mode, click the Page: Properties link at the top of the screen,
as shown in Figure 4-41.

Figure 4-41 Page: Properties Link

o Edliting Views: Graphical | Layout | List Waolbile: Preview
Page Groug: Properies  Page: Propedies Stile Access Create: Sub-Panes
Fatle OmniPortlet Examples

2. Click the Parameters tab.
3. Under New Page Parameter, in the Parameter Name field, enter zip, then click
Add, as shown in Figure 4—42.

Figure 4-42 New Page Parameter

New Page Parameter
Erter a narme for the parameter and click Add.

Parameter Name
fzip Add

4. Under Page Parameter Properties, the new page parameter displays. In the
Default Value field, enter 94065, as shown in Figure 4-43.

Figure 4-43 Default Value for the "zip" Page Parameter

Name Display Name Default Yalue
®x zip zip SA065

5. Under Portlet Parameter Values, you will see a list of portlets listed. If you have
followed all the steps in this chapter, you will see four instances of OmniPortlet
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listed. The Web Services portlet is the first in the list, and the Web Page data
source is the fourth (or the bottom) instance of OmniPortlet in the list.

6. Click the arrow next to the first instance of OmniPortlet to expand the Portlet
Parameters list, as shown in Figure 4—44.

Figure 4-44 Portlet Parameter Values Section

Portlet Parameter Values
Expand a portlet to wiew its parameters and specify how to set the
values.

Portlets
Expand All | Collapse All
= medinipageyroup banner (o parameters)
¥ OmniPortlet

Portlet Parameter

O Param? = Ih
O Param2 = Ih